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Introduction 

About this manual 

This manual contains all that you need to know to operate the PCS 60 software being run via a SpliceCom 
system using version 4 software.  This manual assumes that the PCS 60 software has been loaded and 
configured on your PC by your System Administrator.  If this is not the case please refer to your System 
Administrator for further assistance.   
 

How your PCS 60 will operate 

The PCS 60 software will be configured to either run as an IP soft phone or as a partner to your telephone. 
 
If your PCS 60 is being run as an IP soft phone this means that your PC becomes your telephone and you 
will require a headset and microphone connected in order to facilitate a telephone conversation.  You can 
use this software to make and receive calls wherever your PC has a connection to the SpliceCom system. 
 
If your PCS 60 has been configured to partner your telephone handset this means that your telephone 
conversations will be via the handset but the PCS 60 will assist you to handle calls quickly and efficiently.  If 
you are using your telephone with a headset your conversations will be via your headset and you can use 
the PCS 60 solely to handle the calls. 
 
Windows - When PCS 60 is installed on your PC a shortcut will be automatically created on your 
desktop, double click on this shortcut to run PCS 60.  Otherwise your system administrator will 
inform you how PCS 60 will start on your PC. 
 
Apple Mac –PCS 60 will be available within Applications. Double click on PCS 60 to open this application. 
 
Your User Account 

You are a “User” of the SpliceCom telephone system and as such you have a User account on the system.  
Your Display Name, eg Sarah Forest, will be used to identify you as you make, receive and transfer calls.  
Each of your colleagues will also have a User account and will be identified in the same way, by their 
Display Name.  A list of the Users of your system can be viewed via the Directory page as explained from 
page 18. 
 
Your Display Name will appear at the bottom left hand side of your PCS 60 in the Status Bar. 
 

Apple Mac version 
 

 
MS Windows version 

 
 
As a User on the system you will be given an extension number, eg 2051, and possibly a direct line 
number, eg 01632 563862.  So that when a colleague rings your extension number or an external contact 
rings your direct line number these will be routed to your User account.  Your direct line number may also 
be the number that is presented as your CLI when you make a call, please refer to your system 
administrator for further details. 
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In most implementations the PCS 60 on your PC (IP soft phone) or the telephone on your desk (partner 
mode) will be your permanent phone and as such it will have been automatically allocated to you by your 
system administrator.  Therefore, your User account will be permanently logged on to this handset.  
However, you may wish to log on to another handset if you are required to work in another part of your 
office or you are borrowing a colleague’s PC, or you share a desk and hence the telephone/PC on this 
desk with another colleague(s).  If this is the case, please refer to the Hot Desking/Log In section from 
page 71 for further details. 
 
Your User account will store all of your User settings (as described in the User Configuration section from 
page 39) so that when you log on to another handset these settings will be available to you and your calls 
will be routed to whichever phone you are logged on to. 
 

Guided Tour of the application 

 
 
Menu Bar 

The Menu Bar gives you access to all the features and settings available with your PCS 60.  Click on the 
menu you require and a list of the selectable options is displayed.  Click on the option required.  
Alternatively hover over another menu and the relevant list will be displayed, this can be repeated until the 
option you require is selected.  If you do not wish to select an option from a menu click on the menu 
name and it will disappear. 
 



PCS 60 User Manual 
 

 

 

Introduction 
PCS 60 User Manual v4/1015/6  3 
 

The Menu Bar can also be operated via your keyboard: 
 On a Windows PC press the Alt key on your keyboard plus the underlined letter in the menu name.  To 

make a choice from the menu press the first letter of the option required.  Once a menu has been 
selected via the Alt key the right and left arrow keys on your keyboard can be used to display an 
another menu.  Alternatively, press F10 and use your arrow keys to display the menu required. 

 On an Apple Mac PC the Menu Bar can be accessed by pressing Control-F2 (or Fn-Control-F2) and then 
using the left and right arrow keys.  To make a choice from the menu use the Up and Down arrow 
keys to make the selection and then press Return. 

 
Call Control Toolbar 

This is a context sensitive toolbar displaying icons relevant to the page selected within the Call Information 
Window.  For example, when the Call Info page is displayed the Call Control Toolbar gives you icons to 
allow you to create a conference, add a note, record the call and so on.  Each icon is described in detail 
within the relevant section of this manual, and within the Icons in Brief section from page 82. 
 
The Call Control Toolbar can be customized, hidden or displayed as explained in the Customise your 
PCS 60 section from page 72. 
 
Call Status 

This area displays the details of your current call giving the name (if known) and number of the incoming 
caller or of the number you have called.  When you receive a call this area will display whether the call was 
made to your extension or DDI number, or to a Department, or to a colleague who has forwarded their 
calls to you, allowing you to deal with the call in the required manner. 
 
Call Information Window 

This window enables you to select from a choice of pages giving access to the telephone directories, your 
voicemail messages, redial information, a web browser window, call information and a dial pad for use 
with an auto attendant.  Please refer to page 17 for a detailed description of each page. 
 
Favourites 

This pane within the PCS 60 displays your Park icons and will display your Speed Dials once configured.  A 
Speed Dial will allow you to quickly and easily make a call or transfer a call to a regularly used internal or 
external number.  It will also act as a Busy Lamp Field when configured for an internal extension and allow 
you to pick up a call ringing on that extension.  Please refer to page 48 for details on how to create a 
Speed Dial.  Your Park icons will allow you to place a call on hold in a system area thereby releasing your 
phone.  For further information on parking a call please refer to the Parking a call section from page 14. 
 
Status Bar 

The Status Bar will display your name as the currently logged in User together with the number of new 
messages you have received, the number of old messages (Apple Mac version only) stored in your 
voicemail box and the number of calls missed and not answered.  This bar is purely for information that 
enables you, at a quick glance, to ascertain the status of your extension and is described further in the 
relevant sections of this manual. 
 
Dial Box 

This text box is available when the Web, Directory or Call Info pages are selected within the Call 
Information Window and will enable you to enter the number or name of the person you wish to call.  
Please refer to the Make a Call section from page 7 for further details. 
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Quick Settings 

These list boxes allow you to quickly turn on/off regularly used configuration settings such as Do Not 
Disturb and forwarding.  Each option is described in more detail in the relevant section of this manual. 
 
The Quick Settings pane can be turned on or off by selecting Show Quick Settings from the View menu. 
 
Please note: if your Quick Settings pane is not displayed you have been given restricted access to your 
configuration options.  Please refer to your System Administrator for further information. 
 
Resizing the application window 

Apple Mac version – point your mouse at the bottom right hand corner of the window and drag the 
mouse in or out to make the window smaller or larger as required. 
 
Windows version – point your mouse at the outside edge of the window and the pointer will become a 
double headed arrow shape.  Drag your mouse in or out to make the window smaller or larger as required. 
 

Feature Highlights 

Web enabled 

The PCS 60 can display web pages available on the Internet, your company’s intranet and locally on the 
telephone system.  This allows you to have access to the information you require in order to handle your 
calls efficiently. 
 
Access to the System Database 

Your PCS 60 gives you access to a database of information stored on your system that provides directories 
of telephone numbers to help you to quickly and easily make and transfer calls. 
 
Making Notes during a call 

During the process of a call you can attach a note that will help you to remember the caller’s name and 
details or the nature of the call.  This text will then follow the call when it is transferred to help the recipient 
deal with the call proficiently.  If the call is received from or made to an external number stored on the 
central database a note can be saved for future use and referred to at a later date. 
 
Parking a Call 

All calls received can be put on hold and the call remains in your control.  However, another way to place a 
call on hold is to park the call into one of the system areas that allow your colleagues to easily pick up the 
call and in the meantime you are able to continue with other calls.  If you are working on a switchboard or 
at a reception and are dealing with a high volume of calls, you can park calls into a private park areas 
allowing you to continue answering other calls while the previous callers remain on hold. 
 
Favourites 

As well as access to the directories stored on the telephone system’s database you can also set up your 
own list of “favourite” numbers that you regularly call or transfer calls to.  Your Favourites will also act as 
Busy Lamp Fields indicating when internal extensions are engaged or receiving calls and allow you to pick 
up a call ringing on a colleague’s extension. 
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Voicemail 

The SpliceCom system provides standard voicemail functionality which can be enabled on your system and 
for you as a User allowing your callers to leave a message if you are unable to deal with a call.  Your PCS 60 
allows you to easily manage these messages. 
 
Hot Desking 

If you share your PC or telephone handset with other colleagues the PCS 60 software will allow you and 
your colleagues to log in using your own extension number and access code so that you can use your own 
settings and be identified with your name when you make and receive calls. 
 
Using PCS 60 with Vision 

If you are an agent within a SpliceCom Vision Call Centre PCS 60 will help you to handle the calls you 
receive and your Agent call statistics will be displayed within the Status Bar.  If configured on your system, 
Completion Codes will be displayed and can be selected via a separate PCS 60 window, you can select 
Not Available Codes from the Quick Settings bar, and you can alert your supervisor that you need help via 
the Agent Help icon within the Favourites pane. 
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Unified Communication Devices 

SpliceCom offer a wide range of phones and voice apps that allow you to unify your communications in 
the way you’ve always wanted to. From the striking PCS family of desktop phones, through IP Softphones 
for Smart Phones, Tablets, PCs and Macs, to simple analogue phones; there’s something for everyone in 
SpliceCom family of Unified Communication Devices. 
 

There’s also an extensive collection of Unified Control applications to provide comprehensive desktop 
control of voice natively via your Windows or Mac computer or internet browser. These range from “Phone 
Partners”, delivering all of SpliceCom’s value-added system features to analogue phone users to full voice 
integration with your core IT business apps, be they CRM, ERP or PIMs. 
 
And because all of SpliceCom’s core voice platforms, devices and apps have been developed in-house by 
the same team, they all work together and are interchangeable. You can handle your communications on 
one device, or many – it’s your choice, based on the way you want to work. Advanced system features are 
implemented in a common way across all devices, making it easy to switch from one to another. 
 
Navigate is a Phone Partner application, delivering powerful personal call management features via 
Windows 7, Windows 8 & Windows 8.1 PCs for users of SpliceCom’s broad range of PCS IP Phones, or 
existing 3rd party analogue telephones. Providing point and click access to both commonly used and 
advanced SpliceCom voice & integrated Microsoft features (additional licence required for Microsoft 
support), Navigate provides a single intuitive interface to manage business communications for all 
employees across an organization, irrespective of their role. Navigate can also be used as an IP Softphone 
with the addition of an associated licence. 
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Basic Call Handling 

Make a Call 

1. In the Dial Box enter the number to be dialled (internal or external number).  (The Dial Box is 
available when the Web, Directory or Call Info pages are displayed.) 

2. Press Enter and the call will be made. 
 

 

 
 
(Please note that as soon as you start typing in the Dial Box the Directory page will be automatically 
displayed and if the numbers you have entered are matched within the system directories the relevant 
record will be displayed.  Please refer to the Directory section from page 18 for further details.) 
 
Call Status will display the number you have dialled, your name and the length of time of the call has been 
ringing.  If the number dialled has been matched within the system directories the relevant name will also 
be displayed. 

 
 

 
 

 

The unanswered outgoing call icon  will be displayed until the call is answered. 
 
If you have started to make a call, have changed your mind and wish to stop the call either replace your 
handset (partner mode), or select the Hang Up icon  on the toolbar, or press Esc. 

Once the call has been answered, the answered outgoing call icon  will be displayed, together with the 
length of time of the call. 
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The Call Info page will also be displayed.  Any notes that have been previously entered against this number 
(if known by the system) will be shown in the Call Notes pane.  The Call History pane gives the name of 
the person you are calling (if known by the system), and the time and date of the call.  This information will 
be used if this call is transferred and will display the route/history of the call. 
 

 
 
Please note that if you are using PCS 60 in partner mode, the telephone conversation will proceed via your 
handset.  If you are using PCS IP phone and you make the call via the PCS 60, the phone will be in 
Speaker/hands free mode.  For any other type of handset, if you make the call via the PCS 60, your 
telephone will ring until the handset is lifted.  If you dial a number via your handset the call will appear in 
Call Status once a connection has been made. 
 
If you wish to make a call by looking up the number in the system directories please refer to the Make a 
call via the Directory page from page 19. 
 

Entering additional digits 

You may be required to enter further digits once a call has been made, for example, when presented with 
an auto attendant, this can be done as follows:  
 

1. Select the Tones page from the Call Information Window 
or 
from the Call menu select Send Tones 

2. Select the number(s) required either by clicking on the numbers with 
your mouse or enter the numbers on your keyboard. 

3. Each number will flash as you enter it. 
 
 

Ring back when free (Apple Mac version and IP phone mode only)  

If the extension you are ringing is busy, the Destination Busy banner will be displayed under the PCS 60 

window.  If this facility is available on your system, the Ring Back icon  will be presented.  Click on this 
icon to set a ring back. 
 
When the relevant extension becomes free you will receive a call from voicemail. 

 

Answer the call by selecting the Answer icon  or by pressing Enter on your keyboard.  The call will then 
be made to the relevant extension and once answered can proceed as normal. 

Notes Pane 

Call history 
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Account Codes 

Accounts codes on a SpliceCom system enable calls to be tracked.  This feature would be useful if you 
wish to bill customers for time spent on their job or calculate the cost of a project, for example.  Please 
refer to your system administrator for further details if you wish to use this facility. 
 
Once configured on your system, you can either enter the account code when you dial the number 
(please refer to your system administrator for the relevant digits to enter); or by pressing Ctrl+O (Cmd+O) 
on your keyboard or by selecting Enter account code from the Call menu and the following dialogue box 
will be displayed. 

 

Enter the code you wish to use in the Enter Account Code field and 
select OK.  Proceed with the call as normal. 

If this dialogue box is automatically displayed when you make a call 
your User account has been configured so that you can only make an 
external call if you enter an Account Code, please refer to your system 
administrator for further details. 

 

Answer a Call 

When you receive a call your PCS 60 will ring and the caller’s details will be 
displayed via floating text on your PC screen (if enabled) together with the name of 
the called User or Department.  (To enable or disable this feature please refer to 
page 71.) 

 

Call Status will display the number received with the call, and if this number is matched in the system 
directories, the name of the caller.  The name of who the call is for is then displayed, this will be your 
name, the name of the colleague who has forwarded their calls to you or a Department name (if you are 
receiving Department calls).  All this information enables you to answer the call in the required manner.  
Finally, the ringing time is displayed at the end. 
 

 
 

 
 

 

The unanswered incoming call icon  will be displayed until the call is answered. 
 
To answer the call select the Answer icon ,  
or 
Click on the entry within Call Status,  
or 
Press Enter 
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or 
From the Call menu select Answer 
or 
Lift your handset (partner mode only) 
 
Please note that if you are using PCS 60 in partner mode, the telephone conversation will proceed via your 
handset.  If you are using a PCS IP phone and you answer the call via PCS 60, the handset will be in 
Speaker/hands free mode.  For any other handset, your telephone will continue to ring until you lift the 
handset. 

Once the call has been answered the incoming answered call icon  will be displayed. 

 

 
 

 
 
The Call Info page will be displayed once the call is answered.  Any notes that have been previously 
entered against this caller (if known by the system) will be shown in the Call Notes pane.  The Call History 
pane gives your name, and the time and date of the call.  This information will be used if this call is 
transferred and will display the route/history of the call. 

 

Reject a call 

1. If you do not wish to answer the call  
a. select the Hang Up icon , or  
b. from the Call menu select Hang Up, or  
c. press Esc 

2. The call will be passed to your Forward on Busy number (if set), or voicemail (if enabled), or 
cancelled 

 

End a Call 

1. Select the Hang Up icon  
or 
From the Call menu select Hang Up 
or 
press Esc 
or 
Replace your handset (partner mode only) 

2. The Call Information Window will display the Web page. 

Notes Pane 

Call history 
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Mute a call 
(IP soft phone only) 
 
The Mute facility will allow you to prevent a caller from hearing, for example, your conversation with 
another colleague.  You will be able to hear the caller but they will not be able to hear you. 

1. From the Call menu select Mute 

2. Your caller will be unable to hear you. 

3. From the Call menu select Mute again to talk to your caller. 
 
If you wish to use the mute facility via an icon on your toolbar, you can add the Mute icon to the Call 
Control toolbar.  Please refer to the Customize the Call Control Toolbar section from page 72 for further 
details.  Once you have configured this you can mute your calls as follows: 

1. Select the Mute icon  

2. The Mute icon will be displayed with a red circle  to indicate that this facility is on.  Your caller will 
be unable to hear you. 

3. Select this icon again to talk to your caller 
 

Place a call on hold 

1. Select the Hold icon  
or 
from the Call menu select Hold 
(Note that the Hang Up and Hold icons become unavailable.) 

2. External callers will be played “music on hold” if configured.  (Please refer to your System 
Administrator for further details.) 

3. To retrieve the call click on the call within Call Status. 
(Note that the Hang Up and Hold icons become available.) 

 

Transfer a Call 

Announced Transfer 

1. Place the call on hold by selecting the Hold icon . 

2. In the Dial Box type in the number to be dialled (internal or external number). 

3. Press Enter 
or 

1. In the Dial Box enter the number to be dialled (internal or external number). 

2. Press Enter. 

3. The original call will be put on hold. 

4. Wait for the call to be answered and announce the caller 

5. The two calls will be displayed in Call Status 
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6. To transfer the original call, select the Transfer icon , 
or 
from the Call menu select Transfer, 
or  
press Enter. 
You will no longer have control of the call. 

or 

6. To clear the current call and return to the original caller select the Hang Up icon , 
or 
press Esc, 
or 
wait for the other end to hang up. 

or 

6. To return to the original call and place the second call on hold, 
select the Switch icon , 
or  
click on the original call within Call Status, 
or  
from the Call menu select Switch Call. 

7. Use the Switch icon to toggle between the two calls, 
or  
click on the required call within Call Status, 
or  
from the Call menu select Switch Call. 

8. Finally, select the Transfer icon to connect the two calls (regardless of which call you are currently 
connected to). 

or 

8. Select the Hang Up icon to clear the call you are currently connected to and return to the other call 
or 
wait for the other end to hang up 

 
Receiving a transferred call 

If you receive a call from a User who has another call on hold the following information will appear in the 
Call Notes pane of the Call Info page. 

“I have [caller’s name if recognised by the system] (caller’s number) on hold – [name of User making the 
call to you] – time and date.” 
 

 
 
This information will help you to decide whether to accept the transferred call or help you to decide how 
to assist your colleague deal with the call on hold. 
 
Once the call has been transferred to you Call Status will display the name of the original caller.  The name 
of the User who transferred the call will be displayed in the Call History pane of the Call Info page together 
with your name as the next recipient of the call. 
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Unannounced Transfer (Blind Transfer) 

1. Place the call on hold by selecting the Hold icon . 

2. In the Dial Box enter the number to be dialled (internal or external number). 

3. Press Enter. 
or 

1. In the Dial Box enter the number to be dialled (internal or external number). 

2. Press Enter. 

3. The original call will be put on hold. 

4. Once the ringing tone is heard select the Transfer icon , 
or 
press Enter. 
You will no longer have control of the call. 

 
Receiving an unannounced transfer 

If you are the recipient of an unannounced transfer answer the call in the normal way.  Call Status will 
display the name of the original caller.  The name of the User who transferred the call will be displayed in 
the Call History pane of the Call Info page together with your name as the next recipient of the call. 
 

 
 

Add a note to a call 

During a call you may wish to make notes about the call, for example, the caller’s name, the details of the 
enquiry, etc.  This information not only acts as a reminder for you but will also be passed to another User 
when the call is transferred (available to users of a PCS 60, PCS IP Phone and Navigate). 
 

1. During a call click on the Add Note icon , 
or 
from the Call menu select Add Note. 

2. Enter any text in the Note box. 

 

3. Select Add to Call, 

4. The text together with your name as the originator of the note and the date and time will appear in 
the Call Notes pane of the Call Info page.  This information will be passed on with the call if it is 
transferred. 
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5. This text will disappear once the call has ended. 
 
Please note that if the Add to Contact button is available in the Note box this means that the call has been 
made to or received from a number stored in the Contacts Directory.  Please refer to the Contacts section 
from page 31 for further information. 
 

Parking a call 

The Park facility allows calls to be put on hold in a system area, rather than on your phone.  Either, a 
colleague can pick up the call (if they have access to the same park slot), or you can pick up the call when 
you wish to return to the caller. This is useful as another method to transfer a call, or if you wish to deal 
with other calls while a call is on hold. 
 
By default, you will be given access to Park slots 1, 2, 3 and 4 via the four Park 
icons displayed in the Favourites pane.  By default, all your colleagues using a 
PCS 60, Navigate or PCS 58x/57x/56x/55x/542 will also have access to these 
same park slots.   (This default configuration may be different on your system, 
please refer to your system administrator for further details.) 

 
 
A call will remain parked for 5 minutes (default), after this time the call will be represented to your 
extension and you can answer the call in the normal way. 
 

Park a call 

1. Click on one of the four Park icons. 

2. The details of the caller will be displayed within the Park icon.     
 

Pick up a parked call 

Click on the required Park icon 
 

Transfer a parked call 

1. Make a call to the intended recipient of the parked call (internal or external number). 

2. Place the call on hold 

3. Click on the relevant Park icon to un-park the call. 

4. The two calls will be displayed in Call Status. 

5. To connect the two calls select the Transfer icon .  You will no longer have control of the call. 
 
For further information on transferring calls please refer to page 11. 
 
Please note: 

 If you wish to resize your Park icons please refer to the Preferences section from page 78 for further 
details. 

 If your Speed Dial Park Label option is turned on, the “Enter park label” dialogue box will appear 
when you click on a Park icon.  Please refer to the Manually label your parked calls section from 
page 74 for further details. 
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 If you pick up a parked call while in the progress of another call, this call will be automatically parked 
in the next available slot. 

 If your colleagues are using an analogue handset, without the use of PCS 60 or Navigate as a 
partner, and wish to pick up a parked call, please refer to your System Administrator for the relevant 
short code. 

 If you are unable to pick up a call parked by a colleague your Park icons may have been configured 
differently or you may be operating within a different “Company” to your colleague.  Please refer to 
your System Administrator for further details. 

 If you belong to a “Company” this Company may be configured with a different Park Timeout to the 
default 5 minutes.  Please refer to your System Administrator for further details. 

 By default your PCS 60 will display four Park icons configured to access Park slots 1, 2, 3 and 4, 
however alternative Park slots can be used and there is no limit to the Park slot number you can use 
eg 15, 98, 2103 and so no.  This means you can have access to Park slots used just by your 
department/team or used only by yourself.  Either your current Park icons can be re-configured, 
please refer to your System Administrator for further details, or you can create your own Park icons 
as described in the Speed Dials (Favourites) section from page 48. 

 If you do not use the Park facility and wish to remove the Park icons, please refer to the Speed Dials 
(Favourites) section from page 48 for further details. 

 

Conference Call 

The conferencing facility allows you to create a 3-way conversation between yourself and two internal 
and/or external calls.  (Please note that this feature must be enabled on your telephone system.  Please 
refer to your System Administrator if this feature is not available.) 
 

Creating a conference call 

1. Make a call to the first number required (internal or external), or you may have already received a 
call from the first member of the conference. 

2. Placed this call on hold. 

3. Make a call to the second number required (internal or external). 

 

4. Once the call has been answered select the Conference icon  
or 
from the Call menu select Conference 

5. You are now in a 3-way conference with your two calls.  Note that the Conference icon now 
displays a red circle indicating that a conference call is in progress.  

 

Cancel a conference call 

You may wish to cancel the conference and return to a 2-way conversation with your calls as follows. 

1. Select the Conference icon . 

2. You will return to the caller that you were last speaking to before creating the conference.  The other 
caller will be put on hold. 
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Use the Switch icon  to toggle between the two calls or click on the call required in Call Status.  Each 
call can be transferred or ended in the normal way. 

You can return to a conference with your two calls at any time by selecting the Conference icon . 

Please note: 
 If you select the Hang Up icon while on a conference you will hang up the caller that you were last 

speaking to before creating the conference, and return to a 2-way conversation with the other call.  
To change this select the call within Call Status and then choose Hang Up. 

 If one of the conference members hangs up you will return to a 2-way conversation with the other 
caller. 

 

End a conference call (partner mode only)  

If you replace your handset while on a conference call, you will end the conference and hang up all the 
calls. 
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Call Information Window 

 
 

Web 

The Web page of the Call Information window provides a web browser so that web pages available on the 
internet or your company’s intranet can be displayed to provide you with information relevant to your calls 
or display real time video such as a feed from a security camera, for example. 
 
The web page displayed when your PCS 60 is idle is called your Home Page and is specified by your System 
Administrator.  This can be a web page displaying your company logo, for example, and give access to 
further web pages and databases stored on your company’s intranet.  Your Home Page can also display 
websites available on the internet (if a connection is available) that might assist you with your job function.  
The default Home Page as shown in the diagram above is stored on the SpliceCom system internal web 
server and can be edited to suit your company’s needs.  Please refer to your System Administrator for 
further information on your Home Page. 
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Directory 

The Directory page of the Call Information window provides access to a database of contact information 
that is stored centrally on your telephone system.  Your System Administrator is responsible for the 
maintenance of this database and will be able to assist you with your queries. 
 

 
 

The type of records displayed is determined by the tick boxes displayed at the bottom of the Directory 
page.  Tick or untick the options as required. 

 Users will display a list of the User accounts on your telephone system allowing you to quickly and 
easily call a colleague.  The search will be made 

 Departments will give access to the list of Departments configured on your system that allow calls to 
be routed efficiently to a group of Users, eg Accounts, Support and so on. 

 Contacts and Company will display the list of external contacts entered on your telephone system 
allowing you to quickly and easily make calls to customers, suppliers, etc.  The Contacts tick box will 
enable the search within the Contact’s Name fields.  The Company tick box will enable the search 
within the Contact’s Company field. 

 Speed Dials will display your personal list of regularly used telephone numbers (Favourites) stored in 
your User account. 

 
Once these options are ticked any numbers you entered in the Dial Box will also be matched within the 
Users, Departments, Contacts or Speed Dials. 
 

View the Directory 

1. Ensure the Directory option(s) you required is ticked, eg Users and/or Departments. 

2. In the Dial Box enter the name of the User or Department or Contact or Company you wish to view. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish, you can continue to enter the name until the entry you require appears at the top of the 
list. 

 
Each column displayed in the Directory can be resized by pointing at the line to the right of the column 
title with your mouse.  A double headed arrow shape will appear.  Hold down your mouse and move the 
column to the left or right. 
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Please note: 
 you can use the Tab key on your keyboard to move between the directory page and the Dial box. 
 you can enter an asterisks (*) in to the Dial box to view all the records in one list 

 
Call Control Toolbar 

The Information icon  will allow you to view the details for the selected record. 
 
The Choose icon  will allow you to dial another number, eg a mobile number, stored with the selected 
record. 
 

Make a call via the Directory page 

1. In the Dial Box enter the name or number of the User or Department or Contact or Company to be 
dialled. 

2. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

3. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required and the call will be made. 
  

Transfer a call via the Directory page 

1. Place the call on hold by selecting the Hold icon . 

2. In the Dial Box enter the name or number of the User or Department or Contact or Company to be 
dialled. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

4. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required and the call will be made. 

5. Wait for the call to be answered and announce the caller. 

6. To transfer the original call select the Transfer icon .  You will no longer have control of the call. 
 
Please note that if you wish to continue talking to the caller while using the Directory ignore step 1.  The 
caller will be put on hold once you make the call in step 4. 
 
For further information on transferring a call please refer to page 11. 
 

Messages 

The Messages page will display the list of voicemail messages you have received, if relevant.  Please refer 
to the Voicemail section from page 60 for further details. 
 
Please note you can also access your voicemail messages via the Recents page (describe below).  
However, the Messages page only displays your voicemail messages, which is useful if you have received 
a large number and do not wish to search for them within the Recents page. 
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Recents 

All calls received or made by your extension will be logged and can be viewed via the Recents page. 
 
The Recents page can also be accessed by clicking on the Messages icon  or the Redial icon .  
When a call has been received that you did not answer the Messages icon will be displayed with the 

Missed Call symbol  to indicate that you have missed a call.  (Once you have visited the Recents page, 
indicating that you have viewed and acknowledge the missed call, the Messages icon will return.) 
 

Identifying the type of call 

 Signifies an answered incoming call. 

 
Signifies an unanswered (or missed) incoming call (up to 10 displayed, then the oldest will be 
deleted). 

 Signifies an answered outgoing call. 

 Signifies an unanswered outgoing call. 

 
Signifies a new/unread voicemail message. 

 
Signifies an old/read voicemail message. 

 
Entries are listed in date and time order with the newest at the top. 
 
The time and date of each call will be displayed; together with the caller’s or recipient’s name (if 
recognised by the system), the caller’s or recipient’s number and your name. 
 

 
 
The Mailbox column will indicate the recipient of the call.  This will be your name, or; if you are receiving 
Department calls, the Department’s name (please refer to the Departments section from page 27 for 
further details), or a colleague’s name if he/she has forwarded his/her calls to your extension. 
 
Each column displayed in the Recents page can be resized by pointing at the line to the right of the 
column title with your mouse.  A double headed arrow shape will appear.  Hold down your mouse and 
move the column to the left or right.  
 

Missed Incoming Calls 

When a call has been received that you did not answer the Messages icon will be displayed with the 

Missed Call symbol  to indicate that you have missed a call.  Once you have viewed the missed call, by 
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viewing the Recents page, the Messages icon will return.  Please note that if a call is answered by 
voicemail and the caller has left a message, this call will not be registered as a missed call. 
 
If you wish to view just your missed incoming calls, select the Missed button. 
 

 
 
The status bar will also indicate the number of calls missed on your extension. 
 

Apple Mac version  
 

MS Windows version  
 
If your PCS 60 is minimized to the System Tray or Dock (please refer to the Preferences section from 
page 78 for further details) the icon will flash when you have a missed call. 
 

Call Control Toolbar 

Choose icon  - if the call selected is from a number recognised by the system, ie an extension number 
or a number stored in a Contact, this icon will open the Choose Number dialogue box allowing you to dial 
another number, eg a mobile number, stored with the relevant User or Contact. 
 

Add Contact icon  - this icon will allow you to create a new Contact where the external number 
displayed in the selected call will automatically populate the Telephone field.  However, you will only be 
able to save the new Contact if given the required permissions to so, please refer to your System 
Administrator for further details.  Please note that if you click on this icon while a call from an internal 
extension number is selected, the User Details form will open instead, or click on this icon while a call from 
an external number stored in a Contact is selected the relevant Contact’s details form will open where you 
can make changes if necessary, however you will not be able to save the changes if you do not have the 
require permissions. 
 

Delete Message icon  - this icon will delete the selected call. 
 

Information icon  - if the call selected is from a number recognised by the system, ie an extension 
number or a number stored in a Contact, this icon will allow you to view further details stored for the 
relevant User or Contact. 
 
For further information on using the Contacts directory please refer to the Contacts section from page 31. 
 

Redial a number 

When you make a call the details of the call are logged and can be viewed via the Recents page.  This 
information enables you to redial the number quickly and easily. 

1. Select the Recents page or click on the Redial icon . 

2. The  and  icons indicate a number you have previously dialled. 
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3. Double click on the entry required and the number displayed will be dialled. 
 

Dial a previous caller 

When you receive a call the details of the call are logged and can be viewed via the Recents page.  This 
information enables you to ring back the caller quickly and easily. 

1. Select the Recents page or click on the Message icon . 

2. The  and  icons indicate an incoming call. 

3. Double click on the entry required and the number displayed will be dialled. 
 
If the caller’s number has been withheld or not received by the system this facility will not be available.  
The Number column will indicate if the caller’s telephone number has been received. 
 

Nuisance Calls 

The Black List icon  will allow you to black list incoming external numbers so that you will no longer 
receive a call from this number; the caller will either be routed to another User or Department, or played a 
message.  However this facility must be available on your system, please refer to your System 
Administrator for further information. 
 

1. Select the Recents page 

2. Select the call which displays the external number you wish to black list. 

3. Select the Black List icon  
or 
from the Voicemail menu select Blacklist Caller 

 

Call Info  
(available while on a call) 
 

Web Page 

Your User account can be configured so that a specific web page can be displayed in the Call Info page 
when you make a call and/or receive a call. 
 
The web page could give you access to sales information when talking to customers, for example, or 
access to company information when in a conversation with members of staff.  You can use this facility to 
view websites available via the Internet or stored on your company’s Intranet or on the telephone system’s 
internal web server to provide you with information to help you with your job function. 
 
If you make an internal call to another user of a PCS 60 or PCS 58x this web page may also be displayed on 
their PCS.  In the same way that if a User configured with a web page rings you their web page may also 
be displayed in your Call Info page. 
 
Please refer to your System Administrator for further information. 
 

Notes pane 

The Notes pane will display any text that has been added to call, either by yourself or by the colleague that 
has transferred the call to you.  For further information please refer to the Add a note to a call section from 
page 13. 
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Call History pane 

The Call History pane will display a list of the internal Users that have handled a call.  So that when a call is 
transferred among several users each User will be able to view who has previously dealt with the caller. 

 
 

Tones 
(available while on a call) 
 
The Tones page will display the Dial Pad to enable you to enter further digits once a call as been made, for 
example, when presented with an auto attendant.  Select the number(s) required either with your mouse 
or via your keyboard.  Each number will flash as it is entered. 
 

Voicemail  
(available while listening to your messages) 
 
This page is used with your voicemail facility, if enabled.  Please refer to the Voicemail section from page 
60 for further information. 
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Users Directory 

The Users Directory allows you to quickly and easily call a colleague without having to remember their 
extension number.  This directory also allows you to call a colleague’s mobile or home number, if stored in 
their User account, and makes it easy for you to transfer calls to all these numbers. 
 

View the Users Directory 

1. From the Call Information window select the Directory page. 

2. Tick the Users option. 

3. In the Dial Box start to enter the name of the User required. 

4. The text entered will be checked against the Users on the system.  The search will be made within 
the User’s First Name & Last Name fields if populated, or Display Name fields.  The Users matching 
the text entered will be displayed. 

5. The list will reduce as more text is entered. 
 

 
 

The red icon  indicates that the extension is currently busy and the blue icon   indicates that this 
extension has Do Not Disturb set. 
 
Please note  

 In order to be able to search for a colleague by their surname, the User’s First Name and Last Name 
fields must be populated on the system.  Please refer to System Administrator if this facility is not 
available on your system. 

 Once the Users option is ticked, if you enter numbers into the Dial Box this text will be checked 
within all the Users’ extension number and phone number fields on the system.  All Users with 
extension and phone numbers, eg mobile numbers, matching the number entered will be 
displayed. 

 To enter your own mobile and/or home number on to the system please refer to the Personal 
Numbers section from page 47 for further details. 

 You can use the Tab key on your keyboard to move between the directory page and the Dial box. 
 You can enter an asterisks (*) in to the Dial box to view all the Users in one list 
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Make a call to a User 

If you know the extension number of the User you wish to call enter this into the Dial Box and press Enter, 
otherwise, 

1. In the Dial Box enter the name or number of the User to be dialled. 

2. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

3. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 

 
Call Status will display the name and number of the User being dialled. 

 
 
Please note that once you starting typing in the Dial Box the Directory page will be automatically viewed, 
therefore you do not need to select the Directory page each time you want to make a call. 
 

Transfer a call to a User 

1. Place the call on hold by selecting the Hold icon  

2. In the Dial Box enter the extension number of the User to be dialled, press Enter, and go to step 5. 
or 
Within the Directory page ensure the Users option is ticked. 
In the Dial Box enter the name or number of the User you wish to dial. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

4. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 

5. Wait for the call to be answered and announce the caller. 

6. To transfer the original call select the Transfer icon .  You will no longer have control of the call. 
 
Please note that if you wish to continue talking to the caller while using the Directory ignore step 1.  The 
caller will be put on hold once you make the call in step 4. 
 
For further information on transferring a call please refer to page 11. 
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View a User’s Details 

1. Within the Directory page, search for and select the User 
required. 

2. Click on the Information icon , 
or 
from the Actions menu select Get Info. 

3. Select OK or Save, or Cancel or Close to exit. 
 
Please note that you will only be able to amend your own details.  
Select Save or OK to save any changes. 

 
 

Make a call to a User’s mobile or home number 

If a User’s home and/or mobile number has been entered in their User account these numbers can be 
easily accessed and dialled.  To enter your own home and/or mobile number please refer to the Personal 
Numbers section from page 47. 
 

1. Within the Directory page select the User required.  

2. Select the Choose icon , 
or 
from the Actions menu select Choose Number to Dial. 

3. The Choose Number or Select Number dialog box will appear 
displaying the numbers stored with this User. 

4. If you wish to dial the Mobile number click on the Mobile 
button or if you wish to dial the Home number click on the 
Home button, and so on. 

  

 
This method can also be used to transfer a call to a User’s mobile or home number. 
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Departments 

Departments are a feature of the SpliceCom system that allows calls to be routed efficiently to a group of 
Users by dialling one number either internally or externally.  
 
The following describes the usage of your PCS 60 when Departments are used on your system. 
 

Working as a member of a Department 

Due to your role in your company you may have been placed in a Group on the system.  For example, if 
you are part of a Sales team you may be placed in a Sales Group, or part of a Reception team or part of a 
Support team you may have been placed in a Group.  The purpose of creating Groups on your system is to 
ensure the efficient handling of incoming calls.  For example, you may wish to ensure all incoming calls to 
Reception are shared among several colleagues to ensure the calls are answered quickly, or you may wish 
to ensure that support calls are shared equally among the Support team.  (Groups can also be used for call 
pick up, please refer to your system administrator for further details, and for forwarding voicemail 
messages, please refer to the Voicemail section from page 60 for further details.) 
 
A Department determines the routing of a call to your Group and your System Administrator will inform 
you if you will be receiving Department calls and how that Department is configured.   
 

Receiving a Department Call 

When you receive a call for a Department, instead of your details being displayed within Call Status, the For 
column will display the Department name.  This allows you to determine, before answering the call, 
whether you are receiving a personal or Department call and allows you to answer the call in the correct 
manner. 
 

 
 
The floating text displayed when a call is received will also display the name of 
the Department being called.   (To enable or disable this feature please refer to 
the Preferences section from page 71.) 

 
 
If you wish to distinguish a Department call from a personal call by using a different ring tune please refer 
to page 56 for further information. 
 

Wrap Up Time 

A Department can be configured with a Wrap Up time whereby at the end of each call received for the 
Department you will not receive any further calls until this time has expired.  The purpose of this feature is 
to give you time to complete any administrative tasks, such as completing a contact report, updating a 
database, and so on.  If this feature has been configured a web page will be displayed in the Call Info 
page when you receive a call for this Department (please refer to the Automatically display a web page 
section on page 29 for further details). 
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You can truncate this Wrap Up time by selecting the Hang Up icon . 
 
If you are an Agent within a Vision Call Centre you may be given a list of Completion Codes to choose from 
during the wrap-up time.  Please refer to the Using PCS 60 with Vision section from page 69 for further 
details. 
 
Please refer to your System Administrator for further information. 
 

Make a call to a Department 

You may wish to talk to any available member of, for example, the Personnel department or Support team.  
Rather than ringing one member of that department only to find they are not available and then having to 
ring another extension, etc. you could ring the relevant Department, if set up.  Your call will be answered 
by any available member of this Department saving you time. 
 
If you know the extension number of the Department you wish to call enter this into the Dial Box and 
press Enter, otherwise 

1. From the Call Information window select the Directory page. 

2. Tick the Departments option. 

3. In the Dial Box enter the name of the Department to be dialled.  

4. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name until the entry you require appears at the top of the 
list. 

5. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 

 

 
 
Please note  

 Once the Departments option is ticked, if you enter numbers into the Dial Box this text will be 
checked within all the Departments’ extension number fields on the system.  All Departments with 
extension numbers matching the number entered will be displayed. 

 Once you starting typing in the Dial Box the Directory page will be automatically viewed, therefore 
you do not need to select the Directory page each time you want to make a call. 
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 you can use the Tab key on your keyboard to move between the directory page and the Dial box. 
 you can enter an asterisks (*) in to the Dial box to view all the Departments in one list 

 

Transfer a call to a Department 

1. Place the call on hold by selecting the Hold icon  

2. In the Dial Box enter the extension number of the Department to be dialled, press Enter, and go to 
step 5. 
or 
Within the Directory page ensure the Directory option is ticked. 
In the Dial Box enter the name or number of the Department you wish to dial. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name or number until the entry you require appears at the 
top of the list. 

4. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 

5. Wait for the call to be answered and announce the caller. 

6. To transfer the original call select the Transfer icon .  You will no longer have control of the call. 
 
Please note that if you wish to continue talking to the caller while using the Directory ignore step 1.  The 
caller will be put on hold once you make the call in step 4. 
 
For further information on transferring a call please refer to page 11. 
 

Automatically display a Web Page 

When you make a call to or receive a call for a Department a web page may be displayed in your Call Info 
page.  This is as a result of the configuration of the Department whereby a Department can be configured 
so that a specific web page will be automatically displayed in the Call Info page of a PCS 60 when a call is 
made to and/or received for the Department.  The web page could give you access to sales information 
when talking to customers, for example, or display a script to be followed when answering calls.  This 
facility can be used to view websites available via the Internet or stored on your company’s Intranet or on 
the telephone system’s internal web server to provide you with information to help you deal with calls to a 
Department. 

Please refer to your System Administrator for further information. 
 

Recents page 

Your Recents page can also display the incoming answered and missed calls received for a Department.  
Your System Administrator can configure this facility for you, if not already available.  This facility will also 
give you access to voicemail messages for the Department, please refer to the Voicemail for Departments 
section from page 67 for further information. 

For further information on using the Recents page please refer to page 20. 



PCS 60 User Manual 
 

 

  Departments 
30  PCS 60 User Manual v4/1015/6 
 

Log in or out of a Group 

As member of a Group there may be situations when you wish to temporarily remove yourself from the 
Group so that you do not receive Department calls.  For example, you may wish to log yourself out of the 
Accounts group when you are working on a particular project and are not to receive general calls, or you 
may wish to have the ability to log yourself into the Reception group when cover is required.  This feature 
must have been previously set up for you on the system, please refer to your System Administrator for 
further details. 
 

1. Select the Login icon  
or 
From the Actions menu select Login 

2. The Groups that you are able to log in or out of are listed in 
the Login dialogue box 

3. Remove the tick to log out of a Group 
or 
Add a tick to log in to a Group. 

4. On an Apple Mac PC the Login screen will automatically 
close after a selection has been made. 
On a Microsoft Windows PC choose Close or Cancel to 
close the dialogue box. 
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Contacts 

A database of external Contacts such as customers, suppliers, etc can be stored on the SpliceCom system.  
Your system administrator is responsible for the maintenance of this database.  The purpose of the 
Contacts database is to match the incoming number of an external call and to display the name of the 
caller in Call Status if a match is found, and to enable you to make external calls to regular contacts quickly 
and easily. 
 

View the Contacts Directory 

The Contacts information displayed will be dependent on the options ticked within the Directory Page.  If 
Contacts is ticked this will enable the search within the Contact’s First and Last Name fields, if populated, or 
within the Name field.  The Company tick box will enable the search within the Contact’s Company field. 
 

1. From the Call Information window select the Directory page. 

2. Tick the Contacts option and, if required, the Company option. 

3. In the Dial Box start to enter the name of the Contact, or name of the Company, required.  The text 
entered will be checked within all the Contacts’ First Name and Last Name fields if populated, or 
Name fields, and the Company field if selected. 

4. The Contacts matching the text entered will be displayed 
 

 
 
Please note  

 In order to be able to search for a Contact by their surname, the Contact’s First Name and Last Name 
fields must be populated on the system.  Please refer to System Administrator if this facility is not 
available on your system. 

 Once the Contacts option is ticked, if you enter numbers into the Dial Box this text will be checked 
within all the Contacts’ phone number fields.  All Contacts with phone numbers matching the 
number entered will be displayed.  If only the Company option is ticked the search will be made 
within the Contact’s Company field only. 

 You can use the Tab key on your keyboard to move between the directory page and the Dial box. 
 You can enter an asterisks (*) in to the Dial box to view all the Contacts in one list 
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Receiving a call from a Contact 

If the incoming number of an external call is matched within the Contacts database the Contact’s name 
will be displayed within Call Status enabling you identify the call and answer the call in the appropriate 
manner. 
 

 
 

Make a call to a Contact 

If you know the number of the Contact you wish to call enter this into the Dial Box and press Enter, 
otherwise, 

1. Ensure the Contacts option and, if required, the Company option, are ticked within the Directory 
page. 

2. In the Dial Box enter the name or number of the Contact to be dialled. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

4. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 

 
Call Status will display the name and number of the Contact being dialled. 

 
 
Please note that once you starting typing in the Dial Box the Directory page will be automatically viewed, 
therefore you do not need to select the Directory page each time you want to make a call. 
 

Transfer a call to a Contact 

1. Place the call on hold by selecting the Hold icon  

2. In the Dial Box enter the number of the Contact to be dialled, press Enter, and go to step 5. 
or 
Within the Directory page ensure the Contacts option, and if required the Company option, are 
ticked. 
In the Dial Box enter the name or number of the Contact you wish to dial. 

3. As you starting typing the list of the records matching the text you have entered will be displayed.   If 
you wish you can continue to enter the name/number until the entry you require appears at the top 
of the list. 

4. If the record you require is displayed at the top of the Directory list, press Enter and the call will be 
made. 
or 
Double click the entry required. 
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5. Wait for the call to be answered and announce the caller 

6. To transfer the original call select the Transfer icon .  You will no longer have control of the call. 
 
Please note that if you wish to continue talking to the caller while using the Directory ignore step 1.  The 
caller will be put on hold once you make the call in step 4. 
 
For further information on transferring a call please refer to page 11. 
 

Make a call to a Contact’s mobile or home number 

If a home number and/or mobile number and/or two additional numbers have been entered for a 
Contact, these numbers can be easily accessed and dialled. 
 

1. Within the Directory page, search for and select the 
Contact required. 

2. From the Toolbar, select the Choose icon . 
or 
from the Actions menu select Choose Number to 
Dial 

3. The Select Number or Choose Number dialog box 
will appear displaying the numbers saved with the 
Contact 

4. If you wish to dial the Mobile number click on the 
Mobile button or if you wish to dial the Home 
number click on the Home button, etc.  

 
This method can also be used to transfer a call to a Contact’s mobile or home number. 
 

Add a note to a Contact during a Call 

During a call you may wish to make notes about the call, for example, the caller’s name, the details of his 
enquiry, etc.  This information not only acts as a reminder for you but will also be passed to another User 
of a PCS 60, Navigate and PCS IP phone when the call is transferred.  If the call has been made to or 
received from a Contact these notes can be stored permanently on the database for future reference. 
 

1. During a call, from the Toolbar, click on the 
Add Note icon  
or 
from the Call menu select Add Note 

2. Enter any text in the Note box 

3. Select Add to Contact 
 

4. The text together with your name as the originator of the note, and the date and time will appear in 
the Call Notes pane of the Call Info page.  This information will be passed with the call if it is 
transferred. 
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The text will be stored permanently with the Contact on the database and will be displayed whenever a call 
is received by or made to this Contact so that you are fully aware of previous conversations with this 
customer, for example. 
 

Viewing Contact Details 

All information, for example, address, telephone numbers etc, stored on the database for a particular 
Contact can be viewed. 
 

 
 

1. Within the Directory page, search for and select the Contact to be viewed. 

2. From the Toolbar, click on the Information icon , 
or 
from the Actions menu select Get Info. 

3. The Contact Details dialog box will be displayed for the selected Contact. 

4. Select Close or Cancel to exit. 
 

Amend a Contact’s details 

Please note that you will only be able to make a change to the details stored for a Contact if given the 
required permission.  Please refer to your system administrator for further information. 
 

1. Within the Directory page, search for and select the Contact to be edited. 

2. From the Toolbar, click on the Information icon . 

3. The Contact Details dialog box will be displayed for the selected Contact. 

4. Make the changes required 

5. Select OK or Save to save the changes. 
 

Create a new Contact 

Please note that you will only be able to add a new Contact to the database if given the required 
permission. Please refer to your system administrator for further information.  A new Contact will be saved 
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in the centralised database and therefore will be available to all your colleagues also using a PCS 60, or 
Navigate or PCS 58x/57x/56x/55x. 
 

1. From the Toolbar, select the Add Contact icon   
or  
from the Actions menu select Add a Contact 

2. The Contact Details form will be displayed.  Enter all the information required. 

3. If you wish to add notes to this Contact select the Note button, and add the note(s) required (see 
Working with Notes below). 

4. When ready, select OK or Save to save the new Contact. 
 

Create a new Contact during a call 

You can also add a new Contact to the database during a call by selecting the Add Contact icon .  The 
caller’s incoming number will be automatically entered in the Telephone number field and further 
information can be added while you are on the call. 
 
If you end the call before completing the new entry the Contact Details form will stay open until you select 
OK. 
 

Create a new Contact from the Recents page 

If you have received a call from or made a call to an external number this call will be listed in your Recents 
page (please refer to the Recents section from page 20 for further details).  The number listed can be used 
to create a new Contact record by selecting the required entry and then clicking on the Add Contact 

icon .  The number displayed will be automatically entered into the Telephone number field of the 
Contact Details form and further information can be added. 
 

Delete a Contact 

Please note that you will only be able to delete a Contact if given the required permission.  Please refer to 
your system administrator for further information.  The Contact will be deleted from the centralised 
database and therefore will no longer be available to your colleagues. 
 

1. Select the Contact to be deleted. 

2. From the Toolbar, click on the Information icon . 

3. The Contact Details dialog box will be displayed for the selected Contact. 

4. Select Delete. 
 

Working with Notes 

If you wish to read, add, amend or delete a note stored within a Contact, open the Contacts Details 
dialogue box as explained above and select the Notes button, then follow the steps below. 
 
Please note that you will only be able to add/amend/delete a Note if given the required permission.  
Please refer to your system administrator for further information. 
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Read a note  

On an Apple Mac PC 

1. The text of each note can be read within the Comment field. 

2. If it is a long note, double click within Comment field and scroll through the text to read to the end. 

3. Press Enter when finished.  (Please note that if you have rights to edit a Contact any changes that 
you accidentally make to the note will be saved when you press Enter, otherwise the changes will 
not be saved.) 

On a Microsoft Windows PC 

1. Select the note by clicking on the Originator’s name. 

2. The text of the note will be displayed within the text box below.  If it is a long note, scroll through 
the text to read to the end. 

Select Cancel or Close to return to the Contact Details form when required. 
 

Add a new note  

On an Apple Mac PC – 

1. Select the Add button. 

2. A new entry will be listed. 

3. Double click within the Comment field of that new entry. 

4. Enter the text required. 

5. Press Enter when finished. 

On a Microsoft Windows PC – 

1. Click within the text box at the bottom. (If you have an existing note selected, de-select this first by 
clicking away from the Originator column.)  

2. Enter the text required. 

3. Select the Add button. 

4. The new entry will be listed above. 

5. Select OK when ready. 

Select OK or Close to return to the Contact Details form when required. 
 

Amend a Note 

On an Apple Mac PC – 

1. Select the Note to be amended. 

2. Double click within the Comment field of that new entry. 

3. Make the changes required 

4. Press Enter when finished 

On a Microsoft Windows PC – 

1. Select the Note to be amended by clicking on the Originator’s name. 

2. In the text box underneath make the changes required. 

3. Select Update when finished. 

Select OK or Close to return to the Contact Details form when required. 
 

Delete a Note 

On an Apple Mac PC – 

1. Select the Note to be deleted. 
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2. Select the Delete button. 

On a Microsoft Windows PC – 

1. Select the Note to be deleted by clicking on the Originator’s name. 

2. Select the Delete button. 

Select OK or Close to return to the Contact Details form when required. 
 

Using a web page with a Contact 

A Contact can be configured so that a web page relevant to that Contact is available when a call is received 
from and/or made to this Contact. The web page configured will be displayed automatically in the Call Info 
page either before or after a call to or from this Contact is answered.  This facility can be used to view 
websites available via the Internet or stored on your company’s Intranet or on the telephone system’s 
internal web server to provide you with information to help you deal with a call to or from the Contact.  
This could be useful if you wish to view your supplier’s web site when on a call, or you wish to view a 
customer’s account information, for example. 
 

Configure a Contact to display a web page 

Please note that you will only be able to make a change to a Contact’s details if given the required 
permission.  Please refer to your system administrator for further information. 
 

1. Within the Directory page, search for and select the Contact to be edited. 

2. Click on the Information icon . 

3. The Contact Details dialog box will be displayed for the selected Contact. 

4. In the Web field enter the address to the web page required, eg www.splicecom.com 

5. From the Auto URL (Windows) or Web Action (Mac) list box select either: 
 Show Info on Ring or Show Web Page on Ring – the web page will be displayed when a call is 

made to and/or received by this Contact, or 
 Show Info on Connect or Show Web Page on Connect – the web page will be displayed once a 

call to and/or from this Contact has been answered. 
(Please note that the No Action option will perform the same function as Show Web Page on Ring.) 

6. From the Dir Auto URL list box select one of the following: 
 Both Way – the web page will be displayed when a call is made to this Contact and when a call 

is received from this Contact, or 
 Incoming – the web page will only be displayed when a call is received from this Contact, or 
 Outgoing – the web page will only be displayed when a call is made to this Contact. 

7. Select OK or Save to save the changes. 
 

 
 

Using an Ambiguous Number 

When a company has a large DDI number range a Contact can be created that will match any incoming 
call from this company so that you and your colleagues are always aware when a call is received from this 
customer/supplier. 
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A question mark (?) is used to specify the part of the telephone number that will vary, eg an entry of 
01256387??? will match a call from 01256387385, 01256387370, 01256387291 etc. 
 

1. Create a new Contact or open the Contact Details for the 
Contact to be amended. 

2. In the Ambiguous field enter the number required using a ? 
where a digit will be variable. 

3. Select OK or Save to save the changes. 
 
Please note: 

 Contacts containing a complete match to the incoming number 
will take priority over a Contact containing an ambiguous 
number. 

 You will only be able to add or amend a Contact if given the 
required permission.  Please refer to your system administrator 
for further information. 

 



PCS 60 User Manual 
 

 

 

User Configuration 
PCS 60 User Manual v4/1015/6  39 
 

User Configuration 

The SpliceCom system gives you the ability to configure features such as call waiting, forwarding, do not 
disturb, speed dials and ring tunes on your extension.  The PCS 60 enables you to configure these facilities 
via an easy to use dialog box or via the Quick Settings bar. 
 
The User Configuration/Preferences form can be accessed by selecting Settings from the Edit menu. 
 

 
 
Please note: 

 If the Settings option from the Edit menu is not available you have not been given the access 
required to change your configuration options. 

 If the Speed Dials tab and Ring Tunes tab are the only tabs that appear in your User 
Configuration/Preferences form you have been given restricted access to this dialogue box.   

Please refer to your System Administrator for further information. 
 

Call Waiting 

The Call Waiting feature allows you to receive a second call while connected to another call. 
 

Turn on Call Waiting 

1. From the Edit menu select Settings. 

2. Select the General tab. 

3. From the Call Waiting list box select Enabled. 

4. Select OK or Save. 
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Handling a waiting call 

1. When a second call is received you will hear an intermittent beep via your PC or in your headset or 
via your telephone handset (partner mode only) and the Call Waiting message will appear on the 
screen.  This message will disappear after a few seconds or alternatively click on the message. 

 

2. Call Status will also display the details of the second call waiting to be answered. 

 

3. To answer the second call click on the call within Call Status.  The first call will be placed on hold. 
 
Alternatively, 

1. Select the Switch  icon and the first call will be placed on hold. 

2. The second call will ring on your extension and you can choose to: 
a. Answer the call - select the Answer icon or press Enter or click on the call in Call Status, or 
b. Hang up the call – from the Call menu select Hang up, or 
c. Send the call to voicemail – from the Call menu select Send to voicemail 

 
When you have two calls active on your phone you can:- 

 Use the Switch  icon to toggle between the two calls. 
 Select the Conference  icon to create a 3-way conference between yourself and the two calls.  

(For further information please refer to the Conference Call from page 15.) 
 Use the Hang Up icon to end the call you are currently connected to. 

 
If you choose to ignore a call waiting on your phone the call will be automatically passed to your Forward 
on No Answer number (if set) or to voicemail (if enabled), otherwise the call will continue to ring on your 
extension. 
 
If you select the Switch icon and choose not to answer the call waiting the caller will be automatically 
passed to your Forward on No Answer number (if set) or to voicemail (if enabled) and you will be returned 
to your previous call, otherwise the call will continue to ring on your extension.  If you select the Switch 
icon and choose to hang up the call waiting the caller will be automatically passed to your Forward on Busy 
number (if set) or to voicemail (if enabled) or the call will be discontinued, and you will be returned to your 
previous call. 
 

Turn off the Intermittent Beep 

When the Call Waiting feature is enabled you may not wish to hear the intermittent beep when a second 
call is received and may wish to be informed visually on the PCS 60 only.  This tone can be turned off as 
follows: 

1. From the Edit menu select Settings 

2. Within the General tab, from the Call Waiting list box select No Tone 

3. Select OK or Save. 
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When the No Tone option is turned on and a second call is received the Call Waiting message will appear 
on the screen, the call will be displayed in Call Status and the Switch icon will become available.  Handle 
the call as described above. 
 

Turn off the Intermittent Beep in the handset only (Partner mode only) 

If you are using the PCS 60 as a partner to your telephone and you wish to use Call Waiting you may not 
want to hear the intermittent beep in your handset when a second call is received but may still wish to 
hear the beep via the PCS 60.  This feature can be set as follows: 

1. From the Edit menu select Settings 

2. Within the General tab, from the Call Waiting list box select Phone Tools 

3. Select OK or Save. 
 
Please note: your PC must have a sound card and speakers in order for you to hear the intermittent beep. 
 

Turn off Call Waiting 

1. From the Edit menu select Settings 

2. Within the General tab, from the Call Waiting list box select None 

3. Select OK or Save. 
 

Call Forwarding 

The Call Forwarding facility enables you to forward calls to a colleague or to your mobile, for example, 
when you are out of the office, not at your desk or on another call to ensure your callers can reach you 
wherever you are or to ensure your calls are dealt with by another member of staff. 
 
Please note: 

 When Follow Me or Forwarding has been set your PCS or analogue handset will provide a broken 
dial tone to remind you that this feature has been enabled. 

 If your calls are forwarded to an internal extension number and that extension is not answered or 
busy the call will be logged as a missed call on your User account, and the caller will be passed to 
your voicemail, if relevant.  If the call is forwarded to an external number, and that phone is not 
answered or busy, both the mobile settings, for example, and your User settings will determine 
what happens to the call, eg your mobile’s voicemail facility may answer the call first. 

 

Using Follow Me 

This facility allows you to configure your extension so that your calls follow you to an internal extension or 
to an external number so that when you are, for example, working at another desk, working at home, or 
using your mobile etc, your calls will still reach you.  You could also use this feature when you are, for 
example, on holiday and wish all your calls to be diverted to your assistant or another colleague. 
 

Turn on Follow Me 

1. From the Edit menu select Settings. 

2. Within the General tab, from the Follow Me list box select one of the following: 
Personal – all calls to your User account, via your extension number or your direct line number, will 
be forwarded, or 
Dual Personal – all calls to your User account will be forwarded, however your handset will also ring.  
This will ensure that you can pick up the call wherever you are, or 
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All – all calls to your User account and any Department calls you receive will be forwarded, or 
Dual All – All calls to your User account and any Department calls you receive will be forwarded, 
however your handset will also ring.  This will ensure that you can pick up the call wherever you are. 

3. In the Follow Me Number field enter the internal or external number to which calls are to be 
forwarded. 

4. Select OK or Save. 
 

 
 
The Dual Personal and Dual All options are useful if you are in role where you are constantly moving away 
from your desk.  You could set your Follow Me to your mobile, for example, so that you can answer calls 
wherever you are, and when you are back at your desk you do not need to turn off Follow Me to answer 
the calls at your desk.  When you have these options set you can set a different ring tune to play on your 
PCS to remind yourself that this feature has been set.  Please refer to the Ring Tunes section from page 55 
for further details. 
 

Turn off Follow Me 

1. From the Edit menu select Settings. 

2. Within the General tab, from the Follow Me list box select None. 

3. Select OK or Save. 
 
You do not need to remove the Follow Number as you may wish to use this number again. 
 

Quick Settings 

Once a Follow Me number has been entered, the Follow Me facility can be turned on and off via the Quick 
Settings bar. 

From the Divert Calls list box select either Personal, Dual Personal, All, Dual All or None. 
 

 
 
If your home, mobile or assistant telephone numbers have been entered in your User account (please 
refer to the Personal Numbers section from page 47 for further details) you can set your Follow Me facility 
to one of these numbers via the Quick Settings bar. 

1. From the Divert Calls list box select either Personal, Dual Personal, All, or Dual All. 

2. From the Divert To list box select Mobile, Home or Assistant. 
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Forward on Busy 

The Forward on Busy feature will redirect your calls to either an internal or external number when you are 
on an existing call or have Do Not Disturb set.  This is useful if you wish to ensure your calls are answered 
by your assistant or another member of your team. 

1. From the Edit menu select Settings. 

2. Select the Forwarding tab. 

3. Select the Forward on Busy tick box. 

4. In the Forward on Busy number field enter the internal or external number to which calls are to be 
forwarded. 

5. Select OK or Save. 

 

To turn off this feature un-tick the Forward On Busy tick box 
 

Forward on No Answer 

The Forward on No Answer feature will redirect your calls to either an internal or external number when 
you do not answer your extension.  This is useful if you wish to ensure your calls are answered by your 
assistant or another member of your team or redirected to your mobile when you are temporarily away 
from your desk. 

1. From the Edit menu select Settings. 

2. Select the Forwarding tab. 

3. Select the Forward on No Answer tick box. 

4. In the Forward on No Answer number field enter the internal or external number to which calls are 
to be forwarded. 

5. Select OK or Save. 

 

To turn off this feature un-tick the Forward On Busy tick box 
 
By default, your extension will ring for 20 seconds before your extension is considered not answered.  Your 
System Administrator will be able to tell you if this default setting has been changed.  
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Receiving a Forwarded Call 

When a colleague’s calls have been forwarded to your extension your colleague’s details will be displayed 
in Call Status and within the floating text.  This information will enable you to identify and answer a 
forwarded call correctly. 

 
 

Out of Office Message 

When you are unable to answer your phone you may wish to inform your colleagues of your whereabouts 
and when you will be available.  An Out of Office Message can be configured and this will be displayed on 
your colleagues’ PCS 60, Navigate, PCS 58x/57x/56x/551 when they attempt to call you. 
 

Setting an Out of Office Message 

1. From the Edit menu select Settings. 

2. Within the General tab, from the Out of Office list box select In Meeting, At Lunch, On Holiday or 
Off Site. 

3. In the Out of Office text box enter the message that will accompany the above message eg “until 
Monday”, “until 3 pm” etc. 

4. Select OK or Save. 
 

 
 
Please note that if you have voicemail enabled on your User account, when you have an Out of Office 
message set your voicemail greeting will also change.  Your callers will be played the In Meeting greeting, 
the At Lunch greeting, the On Holiday greeting or the Off Site greeting depending on the Out of Office 
option selected.  By default, this will be your Permanent Greeting as described in the Recording a Greeting 
section from page 63.  However if you wish to record a specific greeting for each Out of Office message 
please refer to your System Administrator for further details. 
 

Make a call to a colleague with an Out of Office message 

When a call is made to a colleague who has an Out of Office message set this information will appear in 
the Notes pane of the Call Info page.   This feature will not change the manner in which your call is 
handled. 

 
 

Turn off the Out of Office message 

1. From the Edit menu select Settings 

2. Within the General tab, from the Out of Office list box select In the Office 

3. Select OK or Save 
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You do not need to remove the message in the Out of Office text box as you may wish to use this text 
again. 
 

Quick Settings 

Your Out of Office message can be turned on and off via the Quick Settings bar. 

From the Out of Office list box select In Meeting, At Lunch, On Holiday, Off Site, or In the Office to turn 
this feature off. 
 

 
 

Do Not Disturb 

The Do Not Disturb facility allows you to set your extension as permanently busy.  This useful if, for 
example, you are holding a meeting in your office and do not wish to be disturbed. 
 

Turn on Do Not Disturb 

1. From the Edit menu select Settings. 

2. Within the General tab, select the Do Not Disturb tick box. 

3. Select OK or Save. 
 

 
 
Your calls will be automatically passed to your Forward on Busy number, if configured, or to voicemail, if 
enabled, or cancelled.  Calls will be logged in your Missed Calls list. 
 
Partner mode only: your telephone handset will provide a broken dial tone to remind you that this feature 
has been enabled.  
 
When your colleagues view the Users directory via the Directory page a blue icon  beside your name will 
indicate that your extension has Do Not Disturb set.  Your colleagues who are using Navigate, 
PCS 58x/57x/56x/55x will also be informed that you have Do Not Disturb set via the Users directory. 
 

Turn off Do Not Disturb 

1. From the Edit menu select Settings 

2. Within the General tab, de-select the Do Not Disturb tick box 

3. Select OK or Save 
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Quick Settings 

Do Not Disturb can be turned on and off via the Quick Settings bar. 

From the DND list box select Off or On. 

 
 

Do Not Disturb Exception Number 

You may wish to turn on Do Not Disturb but still receive a call from a colleague or an external number.  The 
relevant number can be set as a Do Not Disturb exception as follows. 

Entering a DND Exception Number 

1. From the Edit menu select Settings 

On an Apple Mac PC: 

2. Select the DND page 

3. Click on the Add button (a “new” entry will be added to the DND Exceptions list). 

4. Select the “new” entry. 

5. Enter the internal or external number required. 

6. Press Enter 

7. Select Save 

 
 
On a Microsoft Windows PC: 

2. Select the DND Exceptions tab 

3. In the DND Exception Number field (at the bottom) enter the internal or external number required 

4. Select Add (the number will be displayed in the DND Exceptions list) 

5. Select OK 
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Once a DND Exception number has been entered whenever you turn on Do Not Disturb you will still 
receive calls from this number.  These numbers can stay in the list as long as required to be used each 
time you turn on Do Not Disturb. 
 
Removing a DND Exception Number 

1. From the Edit menu select Settings 

2. Select the DND page or DND Exceptions tab 

3. Select the number to be deleted 

4. Select the Remove or Del button 

5. Select Save or OK 
 

Personal Numbers 

Your home and mobile numbers can be entered on the central database, together with the internal or 
external number that you wish to use as your Assistant number. 
 
These numbers are used: 

1 To identify you when you make a call from your home or mobile telephones.  Your name and 
details will appear in Call Status.  

2 By the Users Directory for speed dialling (please refer to the Make a call to a User’s mobile or 
home number section from page 26 for further details) 

3 By voicemail: 
a. when accessing your messages from your mobile or home phone (please refer to your System 

Administrator for further details) 
b. your callers can be given the option to be transferred to your assistant number rather leave a 

message (please refer to the Using an Assistant telephone number section from page 65 for 
further details). 

4 By the call forwarding facility (please refer to the Call Forwarding section from page 41 for further 
information). 

 
You can also add two additional numbers – Spare 1 and Spare 2.  These numbers will also be used to 
identify you when you make a call into the office from these numbers and by the User Directory for speed 
dialling. 
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Enter your personal numbers 

1. From the Edit menu select Settings 

2. Select the Numbers tab 

3. In the Mobile, Home, Assistant, Spare 1 and Spare 2 Number fields) enter the numbers required. 

4. Select Save or OK 
 

 
 
Please note: 

 You cannot change your extension number. 
 If all the fields are grey then you are unable to edit these fields.  Please refer to your System 

Administrator for further details. 
 Do NOT enter internal extension numbers into the Mobile, Home, Spare1 or Spare2 number fields.  

These fields are used to match incoming CLI and dial external numbers only. 
 

Speed Dials (Favourites) 

The Speed Dial section of your User Configuration form allows you to set up your own personal list of 
regularly used telephone numbers (internal or external).  Speed Dials are displayed and accessed within 
the Favourites pane.  Speed Dials set up for internal extensions will also act as Busy Lamp Fields (BLF) , in 
other words they will indicate when that User is on the phone. 
 

Create a Speed Dial 

1. From the Edit menu select Settings 

2. Select the Speed Dials tab 

On an Apple Mac PC: 

3. Select the Add button 

4. A “new” entry will be displayed in the Speed Dials list 

5. Click in the Description field and enter any text (alpha-numeric characters only) that will identify this 
Speed Dial 

6. Press your Tab key twice to move to the Telephone Number field 

7. Enter the number to be dialled (internal or external number) 

8. Press Enter 

9. Select Save to finish 
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On a Microsoft Windows PC: 

1. In the Description field enter any text (alpha-numeric characters only) that will identify this Speed 
Dial 

2. In the Telephone Number field enter the number to be dialled (internal or external number) 

3. Select Add (the entry will be displayed in the Speed Dial list) 

4. Select OK to finish 
 
Please note: if a telephone number entered in a Speed Dial is also stored in the Contacts or Users 
directory, when a call is made to or received from this number, the text entered in the Description field of 
the Speed Dial will be displayed in Call Status in preference to the name used in the corresponding 
Contact or User directory entry.  
 

Favourites pane 

 

Your Speed Dials will be displayed in the Favourites pane and can be 
used to quickly and easily make calls, transfer calls and pick up calls. 
 
For details on how to resize your Favourites please refer to the 
Preferences section from page 78. 
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A speed dial displayed for an internal extension will act as a Busy Lamp field:–  

 

An internal speed dial displayed with a green icon indicates that your colleague’s 
extension is free 

 

An internal Speed Dial displayed with a red icon indicates that your colleague is currently 
on a call. 

 

 

An internal Speed Dial flashing between a yellow and red icon indicates that either the 
User’s extension is currently ringing or there are calls queuing for that Department.  The 
number of calls waiting to be answered will be displayed.  You can pick up a call ringing 
for this extension or Department by clicking once on the speed dial. 

 

Make a call using a Speed Dial 

Click once on the Speed Dial required and a call to this number will be made automatically. 
 

Transfer a call using a Speed Dial 

1. Click once on the Speed Dial required. 

2. The first call will be placed on hold and a call will be made to the speed dial number. 

3. Wait for the call to be answered. 

4. When ready select the Transfer icon  to transfer the original call. 
 
For further information on transferring a call please refer to page 11. 
 

Viewing your Speed Dials via the Directory page 

If you prefer you can access your Speed Dials via the Directory page, this might be useful if you do not 
wish to display the Favourites pane, or you have a large number of speed dials, for example.  Ensure that 
the Speed Dial option is ticked within the Directory page, and you can search for and use an entry in the 
same manner as described in the Directory section from page 18. 
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Amend a Speed Dial 

1. From the Edit menu select Settings. 

2. Select the Speed Dials tab. 

On an Apple Mac PC: 

3. Select the Speed Dial to be amended. 

4. Click within the field to be amended. 

5. Enter the changes required. 

6. Press Enter. 

7. Select Save to finish. 

On a Microsoft Windows PC: 

3. Select the Speed Dial to be amended. 

4. The Speed Dial will be displayed in the fields below. 

5. Make the changes required. 

6. Select Update. 

7. Select OK to finish. 
 

Delete a Speed Dial 

1. From the Edit menu select Settings. 

2. Select the Speed Dials tab. 

3. Select the Speed Dial to be deleted. 

4. Select the Remove or Delete button. 

5. Select Save or OK to finish. 
 

Grouping Speed Dials 

If you have multiple speed dials you may wish to organise them into Favourite Groups to make them 
easier to find.  For example, you may wish to separate your personal speed dials from your business speed 
dials, or organise your speed dials by project or department, eg Exhibition, Directors, and so on.  Firstly you 
will need to create a Favourite Group and then assign a speed dial to that group. 
 
Create a Favourite Group 

1. Create a new speed dial as described from page 48. 

2. In the Description field enter the name you wish to give the 
group, eg Personal 

3. In the Short Code field enter GH:group number, eg GH:1 

4. Remove any text from the Telephone field so that this field is 
blank 

5. The Favourite Group will appear in your Favourites pane indicated 
by a blue arrow. 
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Assign a Speed Dial to a Favourite Group 

1. Create a new speed dial as described from page 48 or open an 
existing speed dial. 

2. In the Short Code field enter G:group number, eg G:1. 

This speed dial will now be available by selecting the relevant Favourite 
Group. 

Use the Back button to return to main Favourites list. 

 

 
The following diagram gives an example configuration: 

 
 

Prioritising Speed Dials 

All Speed Dials and Favourite Groups will be displayed in alphabetical order.  However if you wish to 
display your speed dials in a different sequence a display order number can be assigned using the 
following methods. 

If you wish to specify where a Speed Dial will be displayed in your Favourites pane, in the Short Code field 
enter PRI:order number, eg PRI:1. 

If you wish to specify where a Favourite Group will be displayed in your Favourites pane, in the Short Code 
field add a comma and then the order number required, eg GH:1,6. 

If you wish to specify where a Speed Dial assigned to a Favourite Group will be displayed within that group, 
in the Short Code field add a comma and then the order number required, eg G:2,1. 
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Call Pick up 

You can pick up a call ringing on another extension via the Favourites pane.  This is useful if, for example, 
you wish to answer your colleague’s phone when they are not at their desk or you wish to assist with 
answering calls to a Department. You do not have to be a member of the Department to pick up a 
Department call. 
 

1. A speed dial displaying a flashing yellow/red icon indicates that the relevant User or 
Department has a call waiting to be answered.  

2. Click once on the Speed Dial. 

3. The call will be answered by your extension. 

 

 
 
Please note: 

 If you pick up a ringing call while you are on a call your original call will be parked in the first 
available park slot.  Please refer to page 14 for further information on parking a call. 

 If you do not wish your colleagues to pick up calls ringing on your phone via their speed dials, 
please contact your System Administrator who can configure this for you. 

 

Create a Speed Dial from the Directory 

A Speed Dial can be created by dragging a User, Department or Contact entry from the Directory to the 
Favourites pane.  The Speed Dial entry will be listed in your User Configuration/Preferences dialogue box 
in the usual manner. 

1. From the Call Information window select the Directory page. 

2. Ensure the option required, eg Users, Departments, Contacts or Company, is ticked. 

3. In the Dial Box start to enter the name or number of the record required. 

4. The records matching the text entered will be displayed. 

5. Drag the entry required into the Favourites pane. 

6. A Speed Dial to the number in the Telephone Number field will be created using the name as it 
appears in the Name field. 

 
The Speed Dial created in this manner can be amended or deleted in the normal way.  Please refer to the 
Amend a Speed Dial section from page 51 for further details. 
 

Assigning a short code to a speed dial 

For numbers that you dial regularly you may prefer to assign a short code to a Speed Dial so, for example, 
you could dial just 33 to ring 01632953492.  (Please note that the short code you use must not be the same 
as a short code you are already using for other system functionality, please refer to your System 
Administrator for further assistance.) 
 

1. Create a new speed dial as described from page 48 or open an existing speed dial. 

2. In the Short Code field enter the digits to be dialled, eg 33. 

3. Select Save or OK to finish. 
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Park icons 

By default all Users of a PCS 60, and Navigate, PCS 58x/57x/56x/55x, within your company will have 
icons/buttons to access park slots 1-4.  However you can choose to: 

 create icons to access any park slots number you wish to use.  This would be useful if you need an 
icon to a park slot that is only going to be used by the colleagues in your department, or you would 
like an icon to a park slot only used by yourself, for example. 

 remove all the Park icons.  This would be useful if, for example, you don’t use the Park facility and 
you wish to have more room for your Favourites. 

 
Please refer to the Parking a call section from page 14 for information on how to use the Parking facility. 
 
Create a Park icon 

1. Create a new speed dial as described from page 48. 

2. In the Telephone Number field enter slot followed by the park slot number to be accessed eg slot5, 
slot8, slot99 etc. 

3. Select Save or OK to finish. 
 
To help you identify the entry, within the Speed Dial list, you can enter any text (alpha-numeric characters) 
in the Description field.  However, this text will not be displayed with icon within the Favourites page.  
“Park #” will always be displayed, eg Park 1, Park 8, Park 99 and so on. 
 
When you create a new Park icon the original icons to park slots 1-4 will be removed from your Favourites 
pane so that only the Park icons you require are displayed.  (If you delete the new Park icon they will 
return.) 
 

 

 
 
However, if you also require icons to access Park Slots 1-4, you can recreate the icons to these Park Slots as 
explained above.  Enter slot1, slot2, slot3 or slot4 in the Telephone Number field. 
 
If you delete all the Park icons that you created via the User Configuration/Preferences form the default 
Park icons to Park Slots 1-4 will return to the Favourites pane. 
 
Remove the Park icons 

If you do not wish to use the Park icons and would prefer to utilize the space for your speed dials these 
can be removed as follows: 

Create a new speed dial as described above and enter slot0 in the 
Telephone Number field. 
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Ring Tunes 

The Ring Tunes section of the User Configuration form allows you to use ring tunes played by your PCS 60 
to distinguish between the different types of incoming calls, for example, between a Department call and 
a call to your User account.  Your PC must have a sound card in order to use the Ring Tunes facility and the 
selected ring tune will be played over your PC’s speakers.  If you are using the PCS 60 application to 
partner your PCS IP phone this configuration will also affect the ring tune used by these handsets.  Any 
other telephone handset will continue to use one of its pre-set ringing cadences. 
 

Change the ring tune for an internal or external call 

You may wish to distinguish between an incoming external call from an incoming internal call by the ring 
tone that you hear. 

1. From the Edit menu select Settings 

2. Select the Ring Tunes tab. 

On an Apple Mac PC: 

3. Select Add 

4. A new entry will be displayed in the Ring Tunes list 

5. From the Type list box select Internal or External. 

6. From the Tune list box select the Tune required. 

7. Select Save to finish. 

 

On a Microsoft Windows PC: 

3. From the Type list box select Internal or External 

4. From the Tune list box select the Tune required. 

5. Select the Add button.  The new entry will appear in the Ring Tunes list. 

6. Select OK to finish 

 
 

Assigning a ring tune to a specific incoming number 

You may wish to assign a ring tune to a specific number so that when you receive a call from a colleague 
or customer, for example, you will be able to recognise their call immediately. 

1. From the Edit menu select Settings 

2. Select the Ring Tunes tab. 

On an Apple Mac PC: 

3. Select Add 

4. A new entry will be displayed in the Ring Tunes list 

5. From the Type list box select Caller ID 

6. Click within the Telephone Number field (or tab to this field) 

7. Enter the incoming number, either internal or external number 

8. From the Tune list box select the Tune required. 

9. Select Save to finish 
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On a Microsoft Windows PC: 

3. From the Type list box select Caller ID 

4. In the Telephone Number field enter the incoming number, either internal or external number 

5. From the Tune list box select the Tune required. 

6. Select the Add button.  The new entry will appear in the Ring Tunes list. 

7. Select OK to finish 
 

 
 

Differentiate a Department call from a call to your extension 

If you are receiving Department calls you may wish to distinguish between a call to your User account and 
a Department call by using a different ring tune. 

1. From the Edit menu select Settings 

2. Select the Ring Tunes tab. 

On an Apple Mac PC: 

3. Select Add 

4. A new entry will be displayed in the Ring Tunes list 

5. From the Type list box select Destination 

6. Click within the Telephone Number field (or tab to this field) 

7. Enter the relevant number - 
If you wish to differentiate calls to your extension from other calls enter your extension number 
here, or 
If you wish to differentiate calls to a specific Department, enter the Department extension number 
here (please refer to your System Administrator if you are unsure which number to use here). 

8. From the Tune list box select the Tune required. 

9. Select Save to finish 

 
 
On a Microsoft Windows PC: 

3. From the Type list box select Destination. 

4. In the Telephone Number field enter the relevant number.   
If you wish to differentiate your User calls from other calls enter your extension number here, or 
If you wish to differentiate calls to a specific Department, enter the Department extension number 
here (please refer to your System Administrator if you are unsure which number to use here). 

5. From the Tune list box select the Tune required. 

6. Select the Add button.  The new entry will appear in the Ring Tunes list.. 

7. Select OK to finish 
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For further information on Departments please refer to page 27. 
 

Assign no ringing sound for a specific incoming call 

If you wish that no ringing is heard for a specific incoming call create the entry as described above 
however in the Tune field select a tune number where no corresponding WAV file is stored on your PC.  By 
default, this will be Ring Tune 7, 8, 9.  Please refer to your system administrator for further assistance. 
 

Assign a ring tune for Follow Me Dual Personal or Dual All 

If you have Follow Me Dual Personal or Dual All set (please refer to page 41 for further details) you may 
wish to have a different ring tune played on your PCS 60 to remind you that this feature has been set. 

1. From the Edit menu select Settings 

2. Select the Ring Tunes tab. 

On an Apple Mac PC: 

1. Select Add 

2. A new entry will be displayed in the Ring Tunes list 

3. From the Type list box select Dual Ringing 

4. From the Tune list box select the Tune required. 

5. Select Save to finish 

 
 
On a Microsoft Windows PC: 

3. From the Type list box select Dual Ringing. 

4. From the Tune list box select the Tune required. 

5. Select the Add button.  The new entry will appear in the Ring Tunes list. 

6. Select OK. 

 
 

System Ring Tune Type 

The System Type is used for calls generated by the telephone system, for example voicemail call-back.  
Please refer to your System Administrator for further information. 
 

Amend a Ring Tune entry 

1. From the Edit menu select Settings. 

2. Select the Ring Tunes tab. 

On an Apple Mac PC: 

3. Select the Ring Tune to be amended 

4. Select the option required from the Type and Tune list boxes if required 

5. If required, click within the Telephone Number field and make the changes 

6. Press Enter 

7. Select Save to finish 



PCS 60 User Manual 
 

 

  User Configuration 
58  PCS 60 User Manual v4/1015/6 
 

On a Microsoft Windows PC: 

3. Select the Ring Tune to be amended 

4. The Ring Tune will be displayed in the fields below  

5. Make the changes required 

6. Select Update 

7. Select OK to finish 
 

Delete a Ring Tune entry 

1. From the Edit menu select Settings 

2. Select the Ring Tunes tab 

3. Select the Ring Tune to be deleted 

4. Select the Remove or Delete button 

5. Select Save or OK to finish 
 

Extension Anywhere 

If you are a user of a PCS IP Phone or an analogue handset and your PCS 60 is partnering this telephone 
you can use the Extension Anywhere feature when you are, for example, working from home.  This feature 
will allow you to receive and make calls from, for example, a home telephone or mobile as though you 
were in the office.  This means callers/recipients will be unaware that you are working from home, you will 
not incur any call charges and you will be able to handle the call as if you were in the office, eg transfer 
calls. 
 
Your System Administrator can configure this facility for you.  Once set up you can use the Extension 
Anywhere list box in your Quick Settings pane to turn this feature on or off.  This option will set your 
Extension Anywhere number, which is the number where you will be making and receiving calls, eg your 
mobile or home number.  The options listed will be dependent on the numbers stored within your User 
account (please refer to the Personal Numbers section from page 47 for further details). 

 
Turn on Extension Anywhere 

From the Extension Anywhere list box in your Quick Settings pane select the number you wish to use, eg 
Mobile or Home.  The options listed here will be dependent on the number stored within your User 
account. 
 

 
 
Please note: 

 If you wish to use your home number for the Extension Anywhere facility but do not wish to 
advertise your home number within the User directory, enter this number in your Assistant field.  
However, it should be noted, that you will not be able to use this facility with voicemail as described 
in the Using an Assistant telephone number section from page 65 (unless, of course, you want to 
divert callers to your home number). 

 Ensure you do not have Follow Me turned on at the same time as Extension Anywhere otherwise 
you will receive two calls, and if you answer the forwarded call you will not be able to use the 
Extension Anywhere facilities, such as the ability to transfer the call. 
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Turn off Extension Anywhere 

From the Extension Anywhere list box in your Quick Settings pane select None 
 
 
Please refer to your system administrator for further information on the Extension Anywhere feature. 
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Voicemail 

The voicemail facility allows your callers to leave you a message if you are on the phone or do not answer 
a call.  The facility must be available on your system and enabled within your User account, please refer to 
your System Administrator for further details, if not already available. 
 

Receiving a Message 

If you are busy on a call or do not answer your phone the caller will be automatically passed to your 
voicemail and will be able to leave a message.  By default, your extension will ring for 20 seconds before 
your extension is considered not answered.  Your System Administrator will be able to tell you if this default 
setting has been changed.  
 
If a caller has left a message the Messages icon  with flash until you have listened to the message. 
 

Apple Mac version 

 

The PCS 60 icon on the Dock with display the number of new messages 
you have received 
 

Windows version  When the PCS 60 application is minimized to the Task Bar the icon will have 
an orange background to indicate you have received a new message.  (If 
the caller hangs up before leaving a message this will also indicate you 
have a missed call to view.)  (When the PCS 60 is minimized to the System 
Tray the PCS 60 icon will flash.) 

 
Partner mode only - The broken dial tone provided by your handset may also indicate that you have a new 
message. 
 

Divert an incoming call to voicemail 

If you do not wish to answer a call and wish to route the caller to your voicemail, from the Call menu select 
Send to Voicemail. 

Please note that if you reject a call you do not wish to answer (via the Hang Up icon or Esc key on your 
keyboard) the call will also be routed to your voicemail unless you have Forward on Busy set. 
 

Status Bar 

The Status Bar will display the number of new messages currently stored in your mailbox to give you a 
quick visual indication of your voicemail status. 
 

Apple Mac version 
 

 
MS Windows version 

 
 

Listen to a message 

1. Select the Messages icon  or select the Recents page from the Call Information window. 
 

If you wish to just view your voicemail messages, select the Messages page. 
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2. A new message will be indicated by a blue envelope . 

3. Double click on the message required 

4. The message will be played and the details of the message, including the date and time of the call, 
will be displayed in the Voicemail page, which will now be displayed. 

 

 
 

5. The message will now be displayed in the Messages page with an open blue icon  as this is now 
an old message and will be deleted after 7 days unless manually saved. 

 

Message Handling 

While a message is being played and displayed in the Voicemail page the following options are available: 
 

 
 

Delete Message  - delete the message permanently. 
 
Forward Message  - forward the message to a colleague(s). 
 
Save Message  - save the message until manually deleted. 
 

Replay Message  - listen to the message again. 
 
Alternatively, from the Voicemail menu select Forward Message, Delete Message, Save Message, or Replay 
Message (Windows only). 
 

Delete a message 

1. From the Call Information window, select the Messages page. 

2. Select the message you wish to delete. 

3. Select the Delete Message icon . 
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Forward a message 

The Forward Message facility allows you to forward a message to a colleague, a group of colleagues, or a 
Department if the content is more relevant to another member of staff, for example.  Please refer to your 
system administrator for details of the Groups available on your system. 
 
Alternatively, you can forward a message to a colleague’s email account or to your own email account.  
The message will appear as a sound file in an email and a PC with a sound card and speakers will be 
required to listen to the message.  (This facility must be previously set up on your telephone system – 
please refer to your System Administrator for further information.) 
 
Forward a message to a colleague’s, a group of colleagues’ or Department’s voicemail 

1. Firstly, ensure that the Directory options required are selected.  (The list of entries displayed in the 
Forward Voicemail dialogue box will be dependent of the options selected within the Directory 
page.  Groups will always be displayed regardless.) 

2. From the Messages or Recents page double click on the message to be forwarded. 

3. Click on the Forward Message  icon. 

4. In the Forward Voicemail window, in the text box at the bottom, start to enter the name of the 
colleague or Group or Department you wish to forward the message to. 

5. Once the name required is displayed, select this User or Group or Department. 

6. Select Send to Mailbox. 

7. A note will be displayed indicating that the message has been forwarded. 

8. You can repeat steps 4 to 7 to forward the message to another colleague or Group or Department. 

9. Select OK or Done when you have finished. 

 
 
Forward a message to an email account 

1. Firstly, ensure that the Users Directory option is selected.  (The list of entries displayed in the Forward 
Voicemail dialogue box will be dependent of the options selected within the Directory page.  
Groups will always be displayed regardless.) 

2. From the Messages or Recents page double click on the message to be forwarded. 

3. Click on the Forward Message  icon. 

4. In the Forward Voicemail window, in the text box at the bottom, start to enter the name of the 
colleague you wish to forward the message to. 

5. Once the name required is displayed, select this User. 
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6. The Email column will display if the User has been configured with an email address for the 
messages to be sent to. 

7. Select Send to Email (this option will not be available if the selected User does not have an email 
account configured). 

8. A note will be displayed indicating that the message has been forwarded. 

9. You can repeat steps 4 to 8 to forward the message to another colleague. 

10. Select OK or Done when you have finished. 

 
 
Forward a message to multiple Users or Departments 

On a Microsoft Windows PC within the Forward Voicemail dialog box use either the Shift or Ctrl key to 
select multiple Users. 
 
On an Apple Mac PC within the Forward Voicemail dialog box use either the Shift or Cmd key to select 
multiple Users. 
 
Please note that you can use the asterisks (*) to view all the entries in one list (dependent on the options 
selected in the Directory page). 
 

Recording a Greeting 

A default message will be played to a caller when transferred to your voicemail.  However you may wish to 
record your own personal message. 
 
You can record two voicemail greetings via your PCS 60.  Firstly, you have a daily greeting that can be used 
to inform a caller of your whereabouts on a particular day, for example – “You have reached Alice Barker’s 
voicemail on Tuesday, 4 July.  I am currently in a meeting until 11 o’clock.  Please leave a message and I 
will call you on my return.”  Your second greeting, the permanent greeting, can be used to give a message 
that can be used on any day, for example – “You have reached Alice Barker’s voicemail. Sorry I am unable 
to take your call. Please leave a message and I will get back to you as soon as possible.”  If you record a 
permanent greeting your daily greeting is deleted at midnight and the permanent greeting is then used 
until a new daily greeting is recorded. 
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You can also record a further four greetings used when you have set an Out of Office message as 
described from page 44.   Your callers will be played the In Meeting greeting, the At Lunch greeting, the 
On Holiday greeting or the Off Site greeting depending on the Out of Office message selected.  By 
default, this will be your Permanent Greeting.  However if you wish to record a specific greeting for each 
Out of Office message please refer to your System Administrator for further details.  
 

Record a daily greeting 

IP soft phone mode 

1. Select the Messages page and select the Greeting icon  
or 
from the Voicemail menu select Greeting 

2. Your existing greeting will be played 

3. When requested record your new greeting. 

4. When finished wait a few seconds in silence. 

5. The new greeting will be played back to you. 

6. Select the Hang Up icon  to save the new greeting and finish. 
 
Partner mode 

1. Select the Messages page and select the Greeting icon  
or 
from the Voicemail menu select Greeting 

2. Lift your handset if necessary 

3. Your existing greeting will be played 

4. When requested record your new greeting and press # on your handset when you have finished. 

5. Your new greeting will be played back to you. 

6. Select the Hang Up icon  to save the new greeting and finish. 
 

Record a permanent greeting 

IP soft phone mode 

1. Select the Messages page and select the PermGreeting icon  
or 
from the Voicemail menu select PermGreeting 

2. Your existing greeting will be played 

3. When requested record your new greeting 

4. When finished wait a few seconds in silence. 

5. The new greeting will be played back to you. 

6. Select the Hang Up icon  to save the new greeting and finish. 
 
Partner mode 

1. Select the Messages page and select the PermGreeting icon  
or 
from the Voicemail menu select PermGreeting 

2. Your existing greeting will be played 

3. When requested record your new greeting and press # on your handset when you have finished. 

4. Your new greeting will be played back to you. 

5. Select the Hang Up icon  to save the new greeting and finish. 
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Using an Assistant telephone number 

You may wish to give your callers the option to be transferred to a colleague, such as your assistant or 
another member of your team, to a Department, or to your mobile rather than leave a message.  The 
Assistant telephone number feature can be configured as follows: 

1. From the Edit menu select Settings 

2. Select the Numbers tab 

3. In the Assistant Number field enter the number which callers are to be transferred to. 

4. Select OK or Save to save the changes. 

 

Once this feature has been configured your callers can press 0 while listening to your greeting and be 
transferred to your Assistant telephone number.  You will need to re-record your greeting to inform your 
callers that facility is available. 
 
Please note 

 If the Assistant field is grey then you are unable to edit this field.  Please refer to your System 
Administrator for further details. 

 The Assistant number is also used with the Call Forwarding feature.  Please refer to page 41 for 
further details. 

 The Assistant number is also used with the Extension Anywhere feature.  Please refer to the 
Extension Anywhere section from page 58 for further information. 

 

Ring back a caller 

After receiving a message from a caller you may wish to ring them back.  The number that was received 
with the original call will be shown within the Number column and the Choose icon will enable you to 
speed dial this number. 

1. Select the Messages icon  or select the Messages or Recents page from the Call Information 
window. 

2. Select the message required. 

3. Select the Choose icon . 

4. The Choose Number or Select Number dialog box will appear. 

5. The number received with the message will be displayed within the Number field.  Select this button 
and the call will be made. 

 
Please note: 
 If the caller’s number has been withheld or not received by the system this facility will not be available.  

The Number column will indicate if the caller’s telephone number has been received. 
 If the number received with the message is matched to a User or Contact stored on the system you 

will be able to use the Choose Number or Select Number dialogue box to dial other numbers, eg a 
mobile number, stored against this User or Contact. 
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Leave a message for a colleague 

You will automatically transfer to your colleague’s voicemail if they are busy or do not answer their phone.  
However you can pre-empt this and transfer directly to their voicemail. 

1. Make a call to your colleague. 

2. Click on the Send to Voicemail icon, or from the Call menu select Send to Voicemail. 

3. Leave a message when requested. 
 

Leave a message for a colleague without dialling the number first 

1. From the Directory page select the User required 

2. Click on the Choose icon  

3. Select the Voicemail button 

4. Leave a message when requested 
 

Transfer a call to a colleague’s voicemail 

1. Place the call on hold by selecting the Hold icon  

2. From the Directory page select the User required 

3. Click on the Choose icon  

4. Select the Voicemail button 

5. You will no longer have control of the call. 
 

Record a Call 

During any call (internal or external or conference call) you can record the conversation.  The resulting 
recording will become a new voicemail message and can be accessed in the usual way. 
 
During a call select the Record  icon, or from the Call menu select Record Call. 

To stop the recording during the call select the Record  icon, or from the Call menu select Record Call.  
(Otherwise, the recording will end when the call is ended.)  If you press the Record icon again, a new 
recording will be made. 
 
Please note that the use of this feature is controlled by your System Administrator.  If the Record icon is not 
available please refer to your System Administrator. 
 

Record a Memo 

You may wish to record a message to yourself, for example when you wish to reminder yourself to 
perform a particular task.  The resulting recording will become a new voicemail message and can be 
accessed in the usual way. 

1. Select the Messages page. 

2. Select the Memo  icon, or from the Voicemail menu select Memo. 

3. Record the message you require. 

4. Select Hang up to finish and save the recording. 
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Please note that the use of this feature is controlled by your System Administrator.  If the Memo icon is not 
available please refer to your System Administrator. 
 

Voicemail for Departments 

Each Department can be configured to use the voicemail service provided by the system.  If voicemail has 
been enabled, a call to a Department will automatically pass to voicemail after the time specified by the 
Department’s configuration on the system.  Please refer to your System Administrator for further details. 
 

Listen to a message for a Department 

Your Messages page can give you access to voicemail messages received for a Department.  Your System 
Administrator can configure this facility for you, if not already available.  You can retrieve and handle the 
messages in the same way as your personal messages.  The Mailbox column will indicate in which mailbox 
the message is stored. 
 

 
 
Your Status Bar will also indicate the voicemail status of the Department. 
 
Apple Mac version: 

 
 
MS Windows version: 

 
 
Please note that if you are able to access Department voicemail messages via your PCS 60 answered and 
missed calls for the Department will also be displayed in your Recents page.  Please refer to Recents 
section on page 20 for further information. 
 

Leave a message for a Department 

1. Make a call to the Department required. 

2. Click on the Send to Voicemail icon, or from the Call menu select Send to Voicemail. 

3. Leave a message when requested. 
 

Leave a message for a Department without dialling the number first 

1. From the Directory page select the Department required. 

2. Click on the Choose icon . 

3. Select the Voicemail button. 

4. Leave a message when requested. 
 

Transfer a call to a Department’s voicemail 

1. Place the call on hold by selecting the Hold icon . 

2. From the Directory page select the Department required. 
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3. Click on the Choose icon . 

4. Select the Voicemail button. 

5. You will no longer have control of the call. 
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Using PCS 60 with Vision 
(MS Windows version only) 
 
If you are an agent within a SpliceCom Vision Call Centre the following features may be available to you.  
For further information on Vision please refer to your System Administrator. 
 

Status Bar 

The Status Bar will display the number of calls you have answered since log in and the number of calls that 
have been presented to your extension but you have not answered.  This information is presented as x(y) 
where x is the number of successive calls that you have not answered, and y is the total number of calls 
you have not answered since log in. 
 

 
 

Completion Codes 

After receiving a call as an agent your phone may be placed in Wrap Up to give 
you time to complete administrative tasks.  Completion Codes can be configured 
to be displayed during this time (these enable your supervisor/manager to 
monitor calls via reports available with Vision). 
 
If configured on your system, when you end the call the Vision Completion Codes 
window will be displayed, select the completion code required.  This may be 
configured to take you immediately out of Wrap-up so that you can take another 
call, or configured to give you extra Wrap-Up time in order to complete further 
tasks.  Your system administrator will inform you of the functionality of each 
completion code. 
 

Not Available Codes 

Not Available Codes can be configured on your system to enable you to inform your supervisor why you 
are unable to take calls.  These will appear in your Quick Settings if configured. 
 

 
 
From the NA Codes list box select the code that is relevant to you.  This code may be configured so that 
you no longer receive Agent calls but can still receive calls to your extension and DDI number, or 
configured to turn on Do Not Disturb so that you do not receive any calls. 
 

 
 
For further information on using DND please refer to the Do Not Disturb section from page 45. 
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Agent Help 

You can alert your supervisor/manager, when you require assistance during a call, via an 
Agent Help icon within your Favourites pane.  This can be set up for you by your system 
administrator, if not already available. 
 
When you click on the Request Help icon, the Agent Help flag appears within your 
supervisor’s/manager’s Supervisor Console application beside your name. 
 
Once the issue has been dealt with the supervisor can cancel the flag via the Supervisor Console 
application, or you can click on your Agent Help icon to cancel the help. 
 
 
For further information on any of these features please refer to your system administrator or the Vision 
User Manual available from your system administrator. 
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PCS 60 Configuration 

Hot Desking/Log In 

If you are a hot desking User, in other words a User who has been given the ability to log in to any phone 
on the system because, for example, you need to move around the building, or you are rarely in the office 
and do not need a permanent telephone, or you share a desk with a colleague, you can log in via a 
PCS 60. 
 
The benefit of logging in with your User account is that all your calls will reach you wherever you are; 
when you make a call the recipient will know the call is from you; you will have access to your User 
configuration and can set features such as DND, Follow Me etc; all your Speed Dials will be accessible to 
you; you will be informed when you receive a new voicemail message and you will be able to easily listen 
to these messages. 
 
You will need to know your extension number and Login Access Code, please refer to your System 
Administrator for these details. 
 
IP Soft Phone mode: If the PC running PCS 60 is used by yourself and other colleagues use the log in 
procedures described below to log in with your User account whenever you sit at this PC. 
 
Partner mode: If the PCS 60 running on the PC you will be using is configured to partner the handset you 
wish to use, by logging on via PCS 60, as described below, you will also be logging on to the associated 
handset.  This is useful if you share a desk with a colleague and therefore the PC and handset on that 
desk.  (You can also log on via the handset and this will automatically update PCS 60 to display your User 
account.  Please refer to the relevant user manual or to your system administrator for further details.) 
 
If you use a laptop, for example, and wish PCS 60 running on this laptop to partner the handset (PCS IP 
phone or analogue handset only) at whichever desk you decide to sit at this can be configured for you.  
Please refer to your system administrator for further details. 
 
Log On 

1. From the Toolbar, select the Login icon  
or 
From the Actions menu select Login 

2. In the Extension Number field enter your 
extension number, eg 2005 

3. In the Access Code field enter your Login Access 
Code, eg 5829 

4. Select the Login button 

 

5. Wait for the PCS 60 to communicate with the telephone system 

6. When the log in is complete the Status Bar will indicate who is currently logged in.  
 

 
 
Please note that if you have a permanent desk elsewhere in the office, and hence a PCS 60 or handset you 
usually use, this PCS 60/handset will become inactive, unless another User logs on to this phone. 
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Log off 

When you have finished using the PCS 60, and handset (partner mode), at the desk you are sitting at, you 
can log yourself out.  You can do this either via the PCS 60 as described below or via the handset (please 
refer to the relevant User manual or your system administrator for further details).  If you have a 
permanent desk elsewhere in the office, and hence a PCS 60 or handset you usually use, your User 
account will be automatically logged back on to this PCS 60 or handset (unless it is being used by another 
User).  Until you log back onto another PCS 60 or handset either manually or automatically, your User 
account will be unavailable therefore your calls will go to your Forward on Busy number (if set), or to 
voicemail (if enabled) or the caller will receive the busy tone. 
 

1. Select the Login icon  
or 
From the Actions menu select Login 

2. Select the Logout button 

3. Wait for the PCS 60 to communicate with the telephone system 

4. PCS 60 will log back in the assigned User (in other words the User permanently allocated to this 
PCS 60 or the partnered handset, if relevant), or display “Searching for Server…”. 

 
Please note that your User account may be configured to automatically log you off after the extension is 
not used for a specified amount of time.  This is useful if you forget to manually log off.  Please refer to 
your System Administrator for further details. 
 

Customise your PCS 60 

Turn on/off Quick Settings 

From the View menu select Show Quick Settings 
 

Hide/Show the Call Control Toolbar 

From the View menu select Hide Toolbar 
 

Customize the Call Control Toolbar 

Which icons are displayed on the Call Control toolbar is context sensitive dependent on the page selected 
within the Call Information window, or whether you are on a call, or listening to a voicemail message, and 
so on.  However, you can change which icons are displayed as follows: 
 
MS Windows version 

1. Select the page that you wish to customize the toolbar for, ie Web, Director, Messages or Recents, 
or wait until the toolbar you wish to customize is displayed, eg when you are on a call. 

2. From the View menu select Customize Toolbar 
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3. In the Customize Toolbar dialogue box: 
a. The icons not currently displayed on the toolbar are listed under “Available toolbar buttons:”. 
b. The icons currently displayed on the toolbar are listed under “Current toolbar buttons:”. 

4. Select the icon required from the “Available toolbar buttons” list, and select Add. 

5. The icon will be listed within the “Current toolbar buttons:” list and displayed on the toolbar. 

Alternatively, 

4. Select the icon you wish to remove within the “Current toolbar buttons:” list and select Remove 

5. The icon will be listed within the “Available toolbar buttons” list 
 
You can also add Separators to your toolbar so that the icons can be grouped by their function and thereby 
making it easier to quickly find the icon you wish to use. 

1. Select the page that you wish to customize the toolbar for, ie Web, Director, Messages or Recent, or 
wait until the toolbar you wish to customize is displayed, eg when you are on a call. 

2. From the View menu select Customize Toolbar. 

3. In the Customize Toolbar dialogue box, within the “Current toolbar buttons:” list select the icon that 
will be displayed after the separator, or select Separator at the bottom. 

4. At the top of the “Available toolbar buttons” list select “Separator”. 

5. Select Add. 

6. The separator will be placed in front of the icon selected. 
 
Apple Mac version 

1. Select the page that you wish to customise the toolbar for, ie Web, Director, Messages or Recents, 
or wait until the toolbar you wish to customise is displayed, eg when you are on a call. 

2. From the View menu select Customize Toolbar 
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3. Drag the icon(s) you wish to use on to the toolbar 

4. Select Done when you have finished. 
 
Alternatively, 

3. Drag the icon(s) you wish to remove off the toolbar. 
 

Manually label your parked calls 

When you park a call the name (if the incoming number is recognised by the system) or number of the 
caller will be displayed within the Park icon.  (For further information on parking a call please refer to the 
Parking a call section from page 14 for further details.)  Alternatively you can determine the information 
displayed by using the Speed Dial Park Label option.  For example, you could use this facility to display the 
caller’s name rather than their number.  This is useful if you receive a lot of calls where the incoming CLI 
will not be matched within the Contacts database.  Alternatively, you could display the name of the 
colleague that the caller is waiting for, this might be useful to ensure your colleagues pick up the correct 
call. 
 
Turn on Speed Dial Park Label 

1. From the File menu select Preferences (MS Windows version), 
or 
From the PCS 60 menu, select Preferences (Apple Mac version). 

2. The Preferences dialogue box will be displayed. 

3. Select the Speed Dial Park Label tick box. 

4. Select OK when ready (MS Windows version), 
or 
Close the dialogue box (Apple Mac version). 

 
Using a Speed Dial Park Label 

1. Click on the Park icon where you wish to park a call. 

2. The “Enter park label” dialogue box is displayed. 

3. In the text box enter the text you wish to display on the Park icon. 

4. Select Park when you are ready. 

5. This text will now be displayed on the relevant Park icon. 
 
This text will also be displayed on all your colleagues’ park icons that access the same park slot. 
 
If you select Cancel within the “Enter park label” dialogue box the call will not be parked. 
 
If you do not enter any text within the “Enter park label” dialogue box and select Park the 
default information will be displayed within the park icon, ie the User’s Display Name or the 
Contact name (if the number is recognised by the system) or the caller’s number. 
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Change the background colour of a Park icon 
(MS Windows version only)  

In order to see more clearly when a call is parked you can change the background 
colour used on your Park icons as follows: 

1. From the File menu select Preferences. 

2. Tick the Park Colour Change tick box. 

3. Click on the Colour button. 

4. From the palette displayed select the colour you wish to use.  This will now be 
displayed within the Colour pane. 

5. Select OK. 
 
Your park icons will be displayed with this back ground colour when a call 
is parked in the relevant park slot. 
 

Operator Console Mode 

Operator Console Mode enables additional information to be displayed within your Speed Dial icons in the 
Favourites pane.  Your System Administrator can configure this facility for you, if not already available.  This 
information is further enhanced by selecting options within the Preferences dialog box as explained 
below.  The purpose of this facility is to give you the data required to deal with calls efficiently when, for 
example, you are a receptionist dealing with a large volume of calls. 
 
Firstly, in order to display the information described below you may need to adjust the Speed Dial Width 
and/or Speed Dial Height as follows: 

1. From the PCS60 or File menu select Preferences. 
2. Drag the Speed Dial Width and/or the Speed Dial Height sliders to enlarge or reduce the size of the 

Speed Dial icons as required. 
3. You will see the size of the icons changing in the Favourites pane. 
4. Select OK (MS Windows version) or select the Close icon (Apple Mac version) when you have 

finished. 
 

When Operator Console Mode is enabled your speed dials will provide you with the following 
information: 

     

The asterisk indicates that the User has Follow Me and/or an Out of Office 
message set. 

    

A blue icon indicates that this User has Do Not Disturb set or is currently logged 
out.  Calls to this extension will go to their Forward on Busy number if set, or to 
voicemail if enabled, or the caller will receive busy. 

 
Message Detail 

You can also view the number of voicemail messages and missed calls that Users and Departments have 
received.  You can enable this as follows: 

1. From the PCS60 or File menu select Preferences. 
2. Tick the Message Detail tick box 



PCS 60 User Manual 
 

 

  PCS 60 Configuration 
76  PCS 60 User Manual v4/1015/6 
 

3. Select OK (MS Windows version) or select the Close icon (Apple Mac version) when you have 
finished. 

The following information will then be displayed: 

    

The numbers in brackets indicate the number of new voicemail messages 
and the number of missed calls for that User or Department.  In the 
picture Adrian has 3 new message and 1 missed calls, and Accounts has 1 
new message and 3 missed calls. 

 

Speed Dial Detail 

The Speed Dial Detail option in the Preferences dialogue box will enable/disable the ability to view the 
more detailed information within a Speed Dial. 

1. From the PCS60 or File menu select Preferences. 
2. Tick the Speed Dial Detail tick box 
3. Select OK (MS Windows version) or select the Close icon (Apple Mac version) when you have 

finished. 
 
The following detail will be displayed within your Speed Dials: 
 

    

When an extension is busy a speed dial will display the number the User is 
connected to, including the name if the number is recognised by the system. 

 

 

A speed dial will indicate when a User has accessed their voicemail to, eg listen to 
message, record a greeting and so on. 

 

    

A speed dial will display when the User is logged out or has Do Not Disturb 
set. 

 

 

A speed dial will indicate when a User has Follow Me set displaying where the User’s calls 
are going to and the type of forwarding set. 

 

A speed dial will display when a Department is in Out of Hours 

 

    

A speed dial will display a User and Department’s Out of Office message, 
when set.  A balloon tip will also be displayed when you hover over the 
Speed Dial.  This is useful if the message is too long to be completely 
displayed in your Speed Dial icon. 
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This Speed Dial Detail information will also be displayed above the Dial box when a User or Department is 
selected within the Directory page (you do not need to have Speed Dial Detail enabled to see this data). 

 
 
Message Detail  

    

If you have Message Detail ticked, as described above, a Speed Dial will detail 
the number of new messages or missed calls for the User or Department 
more clearly. 

 

Speed Dial Extra 

The Speed Dial Extra option in the Preferences dialog box 
will enable/disable an additional Busy Lamp Field window.  
This feature is useful if you have created a large number 
of speed dials and there is insufficient room to display 
these in the Favourites pane. 

1. From the PCS60 or File menu select Preferences. 
2. Tick the Speed Dial Extra tick box 
3. Select OK (MS Windows version) or select the Close 

icon (Apple Mac version) when you have finished. 
 
 

User Administration 

You can be given the ability to amend a User’s DND and forwarding options via a Speed Dial.  You will 
require an Administrator User name and password, please refer to your System Administrator for these 
details. 
 

1. From the PCS60 or File menu select Preferences. 
2. In the Administrator User field enter the 

Administrator name you have been given 
3. In the Administrator Password field enter the 

password you have been given 
4. On the Apple Mac version close the dialog box and 

on the Microsoft Windows version select OK. 
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Right click or CTRL+click on a speed dial configured for a 
User and you will be able to set their forwarding number, 
change their forwarding option and turn Do Not Disturb 
on or off. 

 
 

Preferences 

The Preference dialogue box can be accessed by:  
Apple Mac version –selecting Preference from the PCS 60 menu, or 
Microsoft Windows version – selecting Preferences from the File menu 

 

                 
 
IP Address: The IP address of the module/PCS IP phone that the PCS 60 application will connect to.  Please 
refer to your system administrator for further information. 
 
Port and Partner Login Code: these fields will be used if you are using your PCS 60 as a partner to your 
telephone handset. Please refer to your system administrator for further information. 
 
Hot Desk Number and Hot Desk Code:  These fields, in conjunction with the Port and Partner Login Code 
fields, can be used to assist you if you are a hot desking User.  These fields can be configured to allow you 
to log on to more than one choice of handset and your PCS 60 will automatically partner any of these 
handsets.  This is useful if, for example, you are a laptop user and when you come in to the office you log 
on to any available phone at any available desk.  Your PCS 60 can be configured once to partner any of 
these handsets.  Please refer to your system administrator for further information. 
 
Proxy Server: the IP address of the proxy server to be used by the PCS 60 when viewing web pages.   
Please refer to your system administrator for further information. 
 
Remote BLF: this option will enable or disable the busy lamp field feature when this PCS 60 is used across, 
for example, a VPN connection.  Please note: do not use this feature when this PCS 60 is used on the local 
LAN. 
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Use Voice: (Apple Mac version only)  This option enables or disables the use of the voice messages that 
are given when the grey banner appears at the bottom of the PCS 60 window. 
 
SSL Enable: (Apple Mac version only)  PCS 60 IP Phone only - enables PCS 60 to connect via SSL.  Please 
refer to your system administrator for further details. 
 
Provide DTMF Feedback: By default, this feature is enabled.  However, if this option is disabled the PCS 60 
will ignore DTMF tones coming via the PC microphone. 
 
Speech Input/Output: PCS 60 IP phone only - enables the ability to use, for example, a USB headset for 
your speech rather than the PC’s speaker and microphone.  Install the headset first and then the option 
will be available to be selected from these fields. 
 
Floating Text: Enables or disables the floating text that appears on your PC screen when a call is received.  
On the Apple Mac version click within the colour pane or on the Microsoft Windows version select the 
Colour button to change the default colour of this text. 
 
Park Colour Change (MS Windows version only): Enable or disables the use of a coloured background on 
your Park icons when a call is parked.  To select the colour you wish to use click on the Colour button.  
Select the colour from the palette displayed. 
 
Multiple Instances (Microsoft Windows version only): Enables or disables the ability to run more than one 
PCS 60 on your PC when, for example, as part of your job role you need to monitor a colleague’s phone, 
voicemail etc.  You can run another copy of the PCS 60 software and this would be configured to partner 
your colleague’s extension.  Please refer to your System Administrator for further information.  If you wish 
to run more than one version of the PCS 60 on an Apple Mac PC please refer to System Administrator for 
assistance with this feature. 
 
Console Mode or Dedicated Console Mode: When enabled the Call Info page will not display until a call 
has been answered.  This is useful when the Auto URL On Ring feature is used for Department calls or for 
calls from a specific Contact.  The web page will not display on your PCS 60 until the call has been 
answered.  This means that if you are viewing a web page when a call is received this will not be replaced 
by the web page specified by the Auto URL feature unless you decide to answer the call.  Please refer to 
your system administrator for further information. 
 
Start Minimized (Microsoft Windows version only): This option, if selected, will automatically minimise the 
PCS 60 to the System Tray when the application is opened.  This feature will operate when the application 
is next started and will also tick the Minimize to System Tray option, if not already selected. 
 
Auto Minimise or Minimize to System Tray: If enabled, you can minimise the PCS 60 to the Dock or System 
Tray by selecting the Close icon (either in the top left hand corner on the Apple Mac version or at the top 
right hand corner on the Microsoft Windows version).  To view the PCS 60, answer calls and so on click on 
the icon in the Dock or System Tray.  When this feature is enabled use the PCS60 or File menu then Quit or 
Exit to close the application or right click on the icon in the Dock or System Tray and select Quit or Exit. 
 
Pop on Outgoing (partner mode only):  This feature is used in conjunction with the Auto Minimise or 
Minimize to System Tray feature.  If enabled the application will pop up when you lift the handset on your 
phone, or press the Speaker/Handsfree button or dial a number (eg when using Dial Ahead on a 
PCS 580/570/560).  When the call has ended the PCS 60 will minimise back to the Dock or System Tray. 
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Pop on Incoming:  This feature is used in conjunction with the Auto Minimise or Minimize to System Tray 
feature.  If enabled the application will pop up when an incoming call is received.  When the call has 
ended the PCS 60 will minimise back to the Dock or System Tray. 
 
Pop On Connect (partner mode only): This feature is used in conjunction with the Auto Minimise or 
Minimize to System Tray.  If enabled, the application will pop up once a call has been answered by your 
handset.  When the call has ended the PCS 60 will minimise back to the Dock or System Tray. 
 
Balloon Tips: (MS Windows version only)  This feature is used in conjunction with the Auto Minimise or 
Minimize to System Tray feature.  If enabled, a balloon will appear at System Tray giving you the details of 
the call, ie the caller’s name (if the number is recognised by the system), caller’s number and who the call 
is for.  This feature will not be used if Pop on Incoming has been selected. 
 
Speed Dial Width: reduces or increases the width of the Park and Speed Dial icons displayed in the 
Favourites pane. 
 
Speed Dial Height: reduces or increases the height of the Park and Speed Dial icons displayed in the 
Favourites pane. 
 
Speed Dial Extra: Enables or disables the use of the additional Busy Lamp Field window. This option is used 
with the Operator Console Mode feature; please refer to page 75 for further details. 
 
Speed Dial Detail: Enables or disables the ability to view additional information within a Speed Dial.  This 
option is used with the Operator Console Mode feature; please refer to page 75 for further details. 
 
Message Detail: Enables or disables the ability to view the number of new voicemail messages and missed 
calls that Users and Departments have received within a Speed Dial.  This option is used with the Operator 
Console Mode feature; please refer to page 75 for further details. 
 
Speed Dial Park Label: Enables or disables the ability to change the label of a Park icon when parking a call.  
By default the caller’s details will be displayed in the Park icon however with this option enabled when you 
click on the Park Slot required, the Enter Park Label dialogue box will appear and text can be entered eg 
“John Birt for Mark”.  The call will be parked by selecting the Park button.  If you do not wish to change the 
Park icon label ensure there is no text entered in the Enter Park Label dialogue box and select the Park 
button.  Please refer to the Manually label your parked calls section from page 74 for further details. 
 
Change iChat Status: (Apple Mac version only.)  If enabled this option will change your iChat status to 
OnThePhone when you are on a call. 
  
Administrator User: This is the name of the Administrator account to be used to allow you to change User’s 
configuration settings.  Please refer to the Operator Console Mode section from page 75 for further 
details. 
 
Administrator Password: This is the password for the Administrator account entered above. 
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Set up Information 

The version of PCS 60 software being used on an Apple Mac PC can be viewed by selecting the PCS60 
menu and then the About PCS 60 option. 
 

 
 
On the Microsoft Windows version the following information can be viewed by selecting About PCS 60 
from the Help menu: 

 Software version 
 IP address of the PC running PCS 60 
 User currently logged in 
 Extension number of the User 
 IP address of the Call Server to which the PCS 60 is 

connected 
 IP address of the Call Server providing the User’s voicemail 

service. 
 

 



PCS 60 User Manual 
 

 

  Icons in Brief 
82  PCS 60 User Manual v4/1015/6 
 

Icons in Brief 

Your PCS 60 when idle 

 

Displays the Directory page and the Dial Box to enable you to search for an entry on the 
centralised database.  (Please refer to the Directory section from page 18 for further details.) 

 
MS Windows version only.  Create a new Contact entry on the centralised database.  (Please 
refer to the Contacts section from page 31 for further details.) 

 

Enables you to log in or log out from this PCS 60 and log in or out of your Groups.  (Please 
refer to the Hot Desking section from page 71 for further details.) 

 

Displays the Recents page which lists the calls made from your extension enabling you to 
quickly redial a number.  (Please refer to the Recents section from page 20 for further details.)  

 

Displays the Recents page which will lists the calls received by your extension together with 
any voicemail messages you may have received.  If the icon is flashing this indicates that you 
have received a new voicemail message.  (Please refer to the Recents section from page 20 
for further details.) 

 
Displays the Recents page and indicates that your extension has missed a call.  (Please refer 
to the Recents section from page 20 for further details.) 

 

Displays the Messages page and indicates that your extension has missed a call and that you 
have received a new voicemail message.  (Please refer to the Recents section from page 20 
for further details.) 

 
Browsing Web Pages 

 

Return to your Home page 

 

Back a page 

 

Forward a page 

 

Stop the search 

 
Refresh the page 

 
Incoming Call 

 
Answer the incoming call.  (Please refer to the Answer a Call section from page 9 for further 
details.) 

 
Reject the incoming call.  The call will be passed to your Forward on Busy number (if set) or to 
voicemail (if enabled) or cancelled. (Please refer to the Answer a Call section from page 9 for 
further details.) 
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Answered Call (Call Info page) 

 
End the call.  (Please refer to the End a Call section from page 10 for further details.) 

 

Put the call on hold.  (Please refer to the Place a Call on Hold section from page 11 for further 
details.) 

 

Add a note to the call which will be displayed in the Notes pane of the Call Info page.  
(Please refer to the Add a note to a call section from page 13 for further details.) 

 

Record the current call.  (Please refer to the Record a Call section from page 66 for further 
details.) 

 
Create a new Contact entry on the centralised database.  The Caller’s telephone number as 
displayed in Call Status will be entered in the Telephone number field.  (Please refer to the 
Contacts section from page 31 for further details.) 

 

Display the Tones page to enable you to enter additional digits when presented with an auto 
attendant.  (Please refer to the Entering Additional Digits section from page 8 for further 
details.) 

 
Unanswered Call (Call Info page) 

 
End the call.  (Please refer to the End a Call section from page 10 for further details.) 

 
PCS 60 IP Phone for Apple Mac only – if the destination is busy, the Ring Back icon will 
become available (if this facility is available on your system).  Click on this icon to set ring 
back to this internal extension number. 

 
Multiple calls 

 
End the currently connected call. 

 
Connect the two calls displayed in Call Status.  (Please refer to the Transfer a Call section from 
page 11 for further details.) 

 
Create a 3-way conference with the two calls displayed in Call status.  (Please refer to the 
Conference Call section from page 15 for further details.) 

 

Toggle between the two calls displayed in Call Status.  (Please refer to both of the sections 
referred to above for further details.) 

 
Directory page 

 
Display the details for the selected record.  Please refer to the Users Directory (page 7) and 
Contacts (page 31) sections for further details. 

 
Create a new Contact entry on the centralised database.  (Please refer to the Contacts section 
from page 31 for further details.) 

 

Pick a number to dial for the selected record.  Please refer to the Users Directory (page 7) and 
Contacts (page 31) sections for further details. 

 



PCS 60 User Manual 
 

 

  Icons in Brief 
84  PCS 60 User Manual v4/1015/6 
 

Messages page 

 

Record a message that will be stored with your voicemail messages.  (Please refer to the 
Record a Memo section from page 66 for further details.) 

 
Record a daily greeting.  (Please refer to the Recording a Greeting section from page 63 for 
further details.) 

 
Record a permanent greeting.  (Please refer to the Recording a Greeting section from page 
63 for further details.) 

 

Display the details for the selected record. 

 
Create a new Contact entry on the centralised database for the selected caller.  The Caller’s 
telephone number will be entered in the Telephone number field.  (Please refer to the 
Contacts section from page 31 for further details.) 

 
Black list the external number selected.  (Please refer to the Nuisance Calls section from 
page 22 for further details.) 

 
Delete the selected message. 

 
If the selected caller has been recognised by the system this icon will enable you to dial 
numbers stored for this record.  Please refer to the Users Directory (page 7) and Contacts 
(page 31) sections for further details. 

 
Recents  page 

 
Display the details for the selected record. 

 
Create a new Contact entry on the centralised database for the selected call.  The telephone 
number dialled will be entered in the Telephone number field.  Please refer to the Contacts 
section from page 31 for further details. 

 
Black list the external number selected.  (Please refer to the Nuisance Calls section from page 
22 for further details.) 

 

If the number called has been recognised by the system this icon will enable you to dial 
another number stored for this record.  Please refer to the Users Directory (page 7) and 
Contacts (page 31) sections for further details. 

 
Listening to a voicemail message (Voicemail page) 

 
Delete the message currently playing. 

 

Forward the message currently playing to a colleague.  Please refer to the Forward a 
message section from page 62 for further details. 

 

Save the message currently playing until manually deleted 

 
Replay the message. 
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Keyboard Short Cuts 

Your PCS 60 when idle 

MS Windows Apple Mac  
F1 Cmd+1 Display the Directory page 
F2 Cmd+2 Display the Messages page 
F3 Cmd+3 Display the Recents page 
F4 Cmd+4 Display the Call Info page (only when a call is active) 
F5 or Ctrl+O Cmd+0 Enter an Account Code 
F8 or Ctrl+N Cmd+N Create a new Contact 
F10 Cmd+0 Activate the menu bar 
Ctrl+I or Ctrl+H Cmd+I View the version number of the PCS 60 application 
Ctrl+L Cmd+L Open the Login form 
Ctrl+M Cmd+M Minimise your PCS 60 application 

Ctrl+Q Cmd+Q Close the PCS 60 application 
Ctrl+, (comma) Cmd+, (comma) Open the Preferences dialogue box 
Ctrl+Alt+, (comma) Alt+Cmd+, (comma) Open the User Configuration/Preferences dialogue box 

 

Browsing Web Pages 

MS Windows Apple Mac  
Ctrl+C Cmd+C Copy to the clipboard 
Backspace Backspace Back one page 

 

Dial box 

MS Windows Apple Mac  
Arrow keys Arrow keys Move the cursor within the Dial Box 
Delete Delete Delete text in the Dial Box, will delete to the right. 
Backspace Backspace Delete text in the Dial Box, will delete to the left. 

 

Making a Call 

MS Windows Apple Mac  
Enter Enter Dial the number entered in the Dial Box 

Esc Esc End the call 
Ctrl+B Cmd+B Set ring back when free 
Ctrl+O Cmd+O Enter an Account Code 

 

Receiving a Call 

MS Windows Apple Mac  
Enter Enter Answer the call 
Esc Esc Reject the call 

Ctrl+Shift+V Shift+Cmd+V Divert an incoming call to voicemail 
 

Answered call 

MS Windows Apple Mac  
Esc Esc End the call 
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F8 or Ctrl+N Cmd+N Create a new Contact entering the caller’s number in the 
Telephone field 

F5 or Ctrl+O Cmd+0 Enter an Account Code 
Ctrl+R Cmd+R Toggle record the call on/off 
Ctrl+T Cmd+T Go to the Tones page 
Ctrl+W Cmd+W Wrap up call 
Ctrl+Shift+H Shift+Cmd+H Put the call on hold 
Ctrl+Shift+N Shift+Cmd+N Add a note 

 

Multiple Calls 

MS Windows Apple Mac  
Ctrl+S Cmd+S Switch/toggle between the two connected calls 
Ctrl+Shift+C Shift+Cmd+C Create a Conference with the two connected calls 
Ctrl+Shift+T or Enter Shift+Cmd+T or Enter Transfer a call 

 

Directory 

MS Windows Apple Mac  
Ctrl+D Cmd+D Open the Choose Number or Select Number dialogue box for 

the selected record 
Ctrl+I Cmd+I View the selected User’s or Contact’s details 
Ctrl+C Cmd+C Copy text to the clipboard 
Ctrl+V Cmd+V Paste text from the clipboard 
Ctrl+X Cmd+X Cut text to the clipboard 
Ctrl+Z Cmd+Z Undo 
Ctrl+Shift+Z Shift+Cmd+Z Redo 
Esc Esc Return to the Web page 
Tab Tab Move from the Dial Box to the Directory and visa versa 

 

Choose Number/Select Number 

MS Windows Apple Mac  
T T Dial the Telephone number 
M M Dial the Mobile number 
H H Dial the Home number 
1 1 Dial the Spare1 number 
2 2 Dial the Spare2 number 

 

Voicemail (if enabled) 

MS Windows Apple Mac  
Ctrl+G Cmd+G Record a daily greeting 
Ctrl+Shift+R Shift+Cmd+R Record a memo 

 

Messages page 

MS Windows Apple Mac  
Ctrl+D Cmd+D Open the selected User’s or Contact’s Choose Number or Select 

Number form 
Ctrl+I Cmd+I View the selected User’s or Contact’s details 
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Ctrl+N Cmd+N Create a new Contact entering the number received in the 
Telephone field or view the User or Contact details for a number 
recognised by the system 

Ctrl+Shift+B Shift+Cmd+B Blacklist caller 
Del Delete/Backspace Delete the selected message 
Esc Esc Return to the Web page 

 

Listening to voicemail messages (Voicemail page) 

MS Windows Apple Mac  
Ctrl+Shift+F Shift+Cmd+F Forward the message 
Del Del Delete the message 
Ctrl+Shift+S Cmd+S Save the message 

 

Recents page 

MS Windows Apple Mac  
Ctrl+D Cmd+D Open the selected User’s or Contact’s Choose Number or Select 

Number form 
Ctrl+I Cmd+I View the selected User’s or Contact’s details 
Ctrl+N Cmd+N Create a new Contact entering the number received or dialled in 

the Telephone field, or view the User or Contact details for a 
number recognised by the system 

Esc Esc Return to the Web page 
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Index 

add a note 
during a call, 13 
to a contact during a call, 33 

administrator password, 77 
administrator user, 77 
agent help, 70 
ambiguous number, 37 
announced transfer, 11 
answer a call, 9 

answer a department call, 27 
floating text, 9 

auto attendant 
entering numbers while on a call, 8 

auto minimize, 79 
black list callers, 22 
BLF 

remote BLF, 78 
speed dials, 48 
users directory, 24 

blind transfer, 13 
broken dial tone 

do not disturb, 45 
forwarding calls, 41 
voicemail, 60 

busy lamp field 
remote BLF, 78 
speed dials, 48 

call control toolbar, 3 
Call Control Toolbar 

customize, 72 
call forwarding, 41 
call history pane, 23 
call info page, 22 
call information window, 3, 17 
call notes, 4 
call pick up, 53 
call status, 3 
call waiting, 39 
calls history, 20 
calls list, 20 
change iChat status, 80 
cli matching 

via a speed dial, 49 
via a User’s personal numbers, 47 

column width 
directory page, 18 
recents page, 20 

completion codes, 69 
conferencing 

cancel a conference call, 15 
create a conference call, 15 
end a conference call, 16 

contacts, 31 

add a note, 36 
add a note during a call, 33 
ambiguous number, 37 
amend a note, 36 
amend contact details, 34 
contacts directory, 31 
create a contact, 34 
create a contact during a call, 35 
create a contact from the messages page, 35 
delete a contact, 35 
delete a note, 36 
display a web page, 37 
make a call to a contact, 32 
notes, 35 
read a note, 36 
receiving a call from a contact, 32 
transfer a call to a contact, 32 
view contact details, 34 

dedicated console mode, 79 
departments, 27 

automatically display a web page, 29 
groups, 27 
log in or out of a group, 30 
make a call to a department, 28 
receiving a department call, 27 
recents page, 29 
transfer a call to a department, 29 
voicemail, 67 
wrap up time, 27 

dial box, 3 
directory page, 18 

column width, 18 
contacts directory, 31 
departments directory, 28 
users directory, 24 

do not disturb, 45 
exception number, 46 

end a call, 10 
Extension Anywhere, 58 
external ring tune, 55 
favourite groups, 51 
favourites, 3, 4, 48 
floating text, 9 

preferences, 79 
receiving a department call, 27 

follow me, 41 
forward on busy, 43 
forward on no answer, 43 
forwarding calls, 41 

broken dial tone, 41 
grouping speed dials, 51 
groups, 27 

log in or out of a group, 30 
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hang up a call, 10 
hold, 11 
home number, 47 
home page, 17 
hot desking, 5, 71 
icons in brief, 82 
internal ring tune, 55 
ip address, 78, 81 
ip soft phone, 1 
keyboard short cuts, 85 
log in/out 

hot desking, 71 
log in or out of a group, 30 
log in or out of PCS 60, 71 

make a call, 7 
to a contact, 32 
to a department, 28 
to a user, 25 
to a user’s mobile or home number, 26 
using a speed dial, 50 
using the directory, 19 

menu bar, 2 
message detail, 75, 77 
messages page, 19 

voicemail, 60 
minimize to system tray, 79 
missed calls, 20 

department calls, 29 
mobile number, 47 
multiple instances, 79 
mute a call, 11 
not available codes, 69 
nuisance calls, 22 
operator console mode, 75 

message detail, 75, 77 
speed dial detail, 76 
speed dial extra, 77 
user administration, 77 

out of office message, 44 
greeting, 64 

park a call, 4, 14 
create park icons, 54 
park icon colour, 75 
park icon label, 74 
pick up a parked call, 14 
remove park icons, 54 
speed dial park label, 80 
transfer a parked call, 14 

Park Colour Change, 79 
partner your telephone handset, 1 
PCS 60 configuration 

customize the toolbar, 72 
hide/show the toolbar, 72 
operator console mode, 75 
park icon colour, 75 
park icon label, 74 

preferences, 78 
set up information, 81 
turn on/off Quick Settings, 72 
View menu, 72 

pick up a call, 53 
pop on connect, 80 
pop on incoming, 80 
pop on outgoing, 79 
preferences, 78 

administrator password, 77 
administrator user, 77 
auto minimize, 79 
change iChat status, 80 
dedicated console mode, 79 
floating text, 79 
ip address, 78 
message detail, 75, 77 
minimize to system tray, 79 
multiple instances, 79 
park colour change, 75 
Park Colour Change, 79 
pop on connect, 80 
pop on incoming, 80 
pop on outgoing, 79 
provide DTMF feedback, 79 
proxy server, 78 
remote BLF, 78 
speech input/output, 79 
speed dial details, 76 
speed dial extra, 77 
speed dial height, 80 
speed dial park label, 74, 80 
speed dial width, 80 
SSL Enable, 79 
start minimized, 79 
use voice, 79 

prioritising speed dials, 52 
provide DTMF feedback, 79 
proxy server, 78 
quick settings, 4, 42, 45, 46 
recents 

redial a number, 21 
recents page, 20 

black list callers, 22 
calls list, 20 
column width, 20 
departments, 29 
missed calls, 20 
nuisance calls, 22 
ring back a caller, 22 

record a call, 66 
record a memo, 66 
redial a number, 21 
reject a call, 10 
remote BLF, 78 
ring back a caller 
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recents page, 22 
voicemail, 65 

ring back when free, 8 
ring tunes, 55 

amend a ring tune entry, 57 
assign a ring tune to calls to your extension, 56 
assign a ring tune to department calls, 56 
assign ring tune for follow me, 57 
assign ring tune to an incoming number, 55 
delete a ring tune entry, 58 
external ring tune, 55 
internal ring tune, 55 
system ring tune, 57 

set up information, 81 
ip address, 81 
logged in extension, 81 
logged in user, 81 
software version, 81 

short codes 
speed dials, 53 

software version, 81 
speech input/output, 79 
speed dial details, 76 
speed dial extra, 77 
speed dial height, 80 
speed dial park label, 80 
speed dial width, 80 
speed dials, 48 

amend a speed dial, 51 
assign a short code, 53 
busy lamp field, 48 
call pick up, 53 
cli matching, 49 
create a speed dial, 48 
create park icons, 54 
delete a speed dial, 51 
favourite groups, 51 
favourites pane, 49 
grouping speed dials, 51 
make a call using a speed dial, 50 
message detail, 75, 77 
operator console mode, 75 
prioritising speed dials, 52 
remove park icons, 54 
speed dial details, 76 
speed dial extra, 77 
transfer a call using a speed dial, 50 
user administration, 77 

SSL Enable, 79 
start minimized, 79 
status bar, 1, 3 

agent call data, 69 
voicemail, 60 

system database, 4 
tones page, 23 
toolbar, 3 

customize, 72 
transfer a call, 11 

to a contact, 32 
to a department, 29 
to a user, 25 
to voicemail, 66 
using a speed dial, 50 
using the directory, 19 

unannounced transfer, 13 
use voice, 79 
user account, 1 
user administration, 77 
user configuration, 39 

call forwarding, 41 
call waiting, 39 
do not disturb, 45 
follow me, 41 
forward on busy, 43 
forward on no answer, 43 
out of office message, 44 
personal numbers, 47 
quick settings, 42, 45, 46 

user preferences, 39 
users directory, 24 

blf, 24 
make a call to a user, 25 
make a call to a user’s mobile or home number, 26 
transfer a call to a user, 25 
user details, 26 

vision, 69 
agent help, 70 
completion codes, 69 
not available codes, 69 
status bar, 69 

voicemail, 5, 60 
assistant telephone number, 65 
delete a message, 61 
departments, 67 
divert incoming call to voicemail, 60 
forward a message to a colleague, 62 
forward a message to a colleague’s email, 62 
forward a message to multiple colleagues, 63 
leave a message, 66 
listen to a message, 60 
message handling, 61 
messages page, 19 
receive a message, 60 
record a call, 66 
record a daily greeting, 64 
record a greeting, 63 
record a memo, 66 
record a permanent greeting, 64 
ring back a caller, 65 
status bar, 60 
transfer a call to voicemail, 66 
voicemail page, 23 
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web pages, 4, 17, 22 
wrap up time, 27 

wrap-up time, 69 
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